PREFACE

With its grounding in the “guiding pillars of Access, Equity, Equality, Affordability and
Accountability,” the New Education Policy (NEP 2020) envisions flexible curricular structures
and creative combinations for studies across disciplines. Accordingly, the UGC has revised
the CBCS with a new Curriculum and Credit Framework for Undergraduate Programmes
(CCFUP) to further empower the flexible choice based credit system with a multidisciplinary
approach and multiple/ lateral entry-exit options. It is held that this entire exercise shall
leverage the potential of higher education in three-fold ways — learner's personal
enlightenment; her/his constructive public engagement; productive social contribution.
Cumulatively therefore, al academic endeavours taken up under the NEP 2020 framework
are aimed at synergising individual attainments towards the enhancement of our national
goals.

In this epocha moment of a paradigmatic transformation in the higher education
scenario, the role of an Open University is crucial, not just in terms of improving the Gross
Enrolment Ratio (GER) but aso in upholding the qualitative parameters. It is time to
acknowledge that the implementation of the National Higher Education Qualifications
Framework (NHEQF), National Credit Framework (NCrF)and its syncing with the
National Skills Qualification Framework (NSQF) are best optimised in the arena of Open
and Distance Learning that is truly seamless in its horizons. As one of the largest Open
Universities in Eastern India that has been accredited with ‘A’ grade by NAAC in 2021, has
ranked second among Open Universities in the NIRF in 2024, and attained the much
required UGC 12B status, Netaji Subhas Open University is committed to both quantity and
quality in its mission to spread higher education. It was therefore imperative upon us to
embrace NEP 2020, bring in dynamic revisions to our Undergraduate syllabi, and formulate
these Self Learning Materias anew. Our new offering is synchronised with the CCFUP in
integrating domain specific knowledge with multidisciplinary fields, honing of skills that are
relevant to each domain, enhancement of abilities, and of course deep-diving into Indian
Knowledge Systems.

Self Learning Materials (SLM’s) are the mainstay of Student Support Services (SSS) of
an Open University. It is with a futuristic thought that we now offer our learners the choice
of print or eesdm’s. From our mandate of offering quality higher education in the mother
tongue, and from the logistic viewpoint of balancing scholastic needs, we strive to bring out
learning materials in Bengali and English. All our faculty members are constantly engaged
in this academic exercise that combines subject specific academic research with educational
pedagogy.We are privileged in that the expertise of academics across institutions on a
national level also comes together to augment our own faculty strength in developing these
learning materials. We look forward to proactive feedback from all stakeholders whose
participatory zea in the teaching-learning process based on these study materials will enable
us to only get better. On the whole it has been a very challenging task, and | congratulate
everyone in the preparation of these SLM’s.

| wish the venture all success.

Professor Indrajit Lahiri
Authorised Vice-Chancellor
Netgji Subhas Open University
(NSOU)



Netaji Subhas Open University
Four Year Undergraduate Degree Programme
Under National Higher Education Qualifications Framework (NHEQF) &

Curriculum and Credit Framework for Undergraduate Programmes
Course Type: Skill Enhancement Course (SEC)
Course Title: Computer Skills for Humanities and
Allied Disciplines
Course Code: NSE-EG-03

1st Print: March, 2025
Print Order: SC/DTP/472/A dated 08.01.2025

Printed in accordance with the regulations of the University Grants Commission
—Distance Education Bureau



Netaji Subhas Open University

Four Year Undergraduate Degree Programme

Under National Higher Education Qualifications Framework
(NHEQF)& Curriculum and Credit Framework for Undergraduate Programmes

Course Type: Skill Enhancement Course (SEC)

Allied Disciplines
Course Code: NSE-EG-03

Course Title: Computer Skills for Humanities and

Module| Unit Details of Content Writers Course Editor
No. No.
1 1 Dr. Md Intaj Ali
Assistant Professor of English, Debottama Ghosh
Netgji Subhas Open University Assistant Professor
— of English
2 . Dr. Md Intaj Ali . School of Humanities,
Assistant Professor of English, NSOU
Netaji Subhas Open University
3 Dr. Madhurima Nargis,
Assistant Professor of English,
Pandaveswar College, Kazi Nazrul University
4 Dr. Mahamadul Hassan Dhabak
Assistant Professor of English
The Department of Basic Sciences and Humanities, Dr. Md Intaj Ali
B B Raju Institute of Technology, Greater Assistant Professor
Hyderabad, Telangana of English
) ) Netgji Subhas Open
2 5 Ms Hemani Herchandani University
Research Scholar, Manipal University Jaipur
6 Dr. Mahamadul Hassan Dhabak
7 Dr. Madhurima Nargis




3 9 Ms Hemani Herchandani

10 Biswajit Das
Ph. D. Scholar, Department of Comparative
Language and Literature,
University of Calcutta

Dr. Md Intaj Ali
Assistant Professor of
English, Netaji Subhas
11 Rajarshi Das Open University
Librarian (Stage II, Full Time UGC Scale),

Banwarilal Bhalotia College Asansol

12 Dr. Madhurima Nargis
Format Editing Dr Md. Intaj Ali
D%'Q”’P'-ayfom and Assistant Professor of English
o0

Netagji Subhas Open University

Undergraduate Board of Studies for English
Smt Sandhya Sen, Formerly Reader in English, Sarojini Naidu College, Kolkata
Dr Jaydeep Sarangi, Principal, New Alipore College, Kolkata
Dr Tajuddin Ahmed, Associate Professor & Head, Department of English, Aliah University
Professor Himadri Lahiri, Dept. of English, NSOU

Dr Md. Intaj Ali, Assistant Professor of English, NSOU

Soumabha Chakraborty, Assistant Professor of English, NSOU
Debottama Ghosh, Assistant Professor of English, NSOU

Dr Srideep Mukherjee, Officer in Charge, School of Humanities, Head, Dept. of English, NSOU&
Chairperson, Board of Studies

Notification

All rights are reserved. No part of this Self-Learning Material (SLM) may be replicated in any
form without permission in writing from the Registrar of Netaji Subhas Open University.

Ananya Mitra
Registrar (Add’| Charge)




%\vV.La N

&

/1) opi“\s

Wersity

Netaji Subhas NSE-

Open University

Course Title: Computer Skills for Humanities and

Module-1

Unit-1
Unit-2
Unit-3
Unit-4

Module-2 :

Unit-5
Unit-6
Unit 7
Unit 8

Module-3 :

Unit 9

Unit 10
Unit 11
Unit 12

Q

U0 U

a

U0 U

Q
Q
Q
Q

Allied Disciplines
Course Code: NSE-EG-03

. Computer Skills for Humanities and Allied Disciplines
Computer Application in Humanities and Allied Disciplines
Basic Computer Operations and Operating Systems
Formatting Documents
Proofreading

Software Applications and Data Management

Introduction to Basic Software

Word Processing

Spreadsheets

Presentations and Data Visualization Basics

Digital Communication and Networking

Email and Communication Tools
Web Browsing for Research
Project Management Tools
Internet Ethics

EG-03

9-17
18-25
25-40
41-50

53-66
67-76
77-91
92-102

105-114
115-123
124-136
137-145



MODULE 1
Computer Skills for Humanities and Allied Disciplines



NSOU e NSE-EG-03



NSOU ¢ NSE-EG-03 9

Unit 1 O Computer Application in Humanities and Al-

lied Disciplines

Structure

1.1.1 Objectives

1.1.2 Introduction

1.1.3 Database Management

1.14 Digital History

1.1.5 Digital Tools for Research

1.1.6 Geographic Information Systems (GIS) in Humanities
1.1.7 Computer Applications in Literary Studies
1.1.8 Summing Up

1.1.9 Comprehension Exercises

1.1.10 Suggested Readings

1.1.1 Objectives

The main objectives of this unit are the following:

To understand the use of computer applications in humanities and allied disciplines

To formulate the ideas of the changing landscape of discipline and the uses of
computers

To make our learners understand the function of computers in our day-to-day lives
and activities.

To understand the necessity of using computers in humanities and social science
research.

To clear the idea of discipline-wise uses of computer application.
To promote multidisciplinary domains of research with the computer application.

To enable learners to adopt digital technology for liberal arts departments.

1.1.2 Introduction

The widespread dependence on information technology in this 21st century has made
computers an integral part of human lives. Information technology nowadays is being
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heavily used to study the cultural manifestations that characterize the human society itself.
Humanities, being the principal discipline that focuses on human activities as their prime
object of study, particularly the areas like arts, letters, and society, itself demands the
application of digital tools and IT for an unbiased outcome. Arguments regarding the
interaction between IT and human sciences may concern the humanists down through the
ages, but the 21st century, being the age of digitization, demands the all-round application
of all kinds of digital tools, from computers to projectors and from cameras to simulators,
in the further progression of humanistic studies. Humanities, being majorly qualitative in
nature, may seem apparently unfit for the usage of quantitative digital tools, but this classical
concept of humanities itself is a very biased and unaccountable one. There are streams that
heavily demand quantitative analysis, rigorous and unbiased data collection compilation and
management, and those interdisciplinary, multidisciplinary, and transdisciplinary domains of
research cannot move a single step without digital tools. Suppose a student being a permanent
resident of India may choose any country as his/her domain of research, but to collect data,
s/he may not always be able to be physically present in the field due to various obvious
socio-economic constraints. But through computers, the internet, and digital tools and
media, s/he might be able to do comprehensive research on the focused country easily at
his/her own place. The post-covid scenario in Indian as well as world academia witnesses
a significant upsurge of digital and computational applications, especially in the field of
research. Digital classrooms are now being offered in schools, colleges, and universities, as
well as compulsory computer education to make the student future-ready in this fast-
moving world.

We don’t use computers for only a single purpose. Using a computer is always
multifunctional. It works like a machine in which we can complete the task as per our need.
The unit that we are going to read here is to make you understand the role of computers
in our day-to-day lives as well as their necessity in different disciplines. We can’t ignore
the importance and uses of computers, though it is true that we no longer depend on
computers only, as most of the work is being done by our mobiles, iPhones, and tablets.
But still, most of the heavy work is done by the computer only. Most of the disciples use
computers as per their need and necessity. We will see here that we can use computer
applications in humanities and social science research and activities by using different tools
and applications. We are using different software and applications to make our lives and
work easier and more comfortable.

1.1.3 Database Management

This is an era of information and technology. We are living with a huge corpus of data,
and it is regularly increasing day by day. So, managing data is the primary goal of ours.
It is very difficult to manage and store data in one place. That is why we need a database
management system for keeping the file and storing the file systematically. DBMS is a very
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powerful tool to organize, access, and manipulate data. Learners can see the picture to
understand more about different components of the database management system in the
below picture.

Storage
engine

Lock and log
managers

|

Metadata
catalog

|
|

Database
Management

components

Database
access

Query
processor
language

Optimization
engine

Picture has been taken from- https://stratoflow.com/guide-to-database-management-
systems/
A database refers to a structured collection of data stored in a particular central
location. It provides a platform for organizing and retrieving information efficiently. A DBMS
plays an important role in where we can define, create, modify, and access data.
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How Database Management Systems work

Source of the picture- https://stratoflow.com/guide-to-database-management-systems/
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1.1.4 Digital History

Doing research in history becomes much easier in the age of the internet. Most of us
are searching for everything on Google. Even most historical events are available on the
world wide web. It seems most historical information and data can be accessed through
the internet. In the case of oral history, we can find materials in the same place as stated
above. The search provides information as we give inputs in the form of keywords. The
search result may lead us to different kinds of websites, including resources and links to
digital materials from hundreds of libraries, archives, museums, and Wikipedia pages. It is
not easy to define digital history in a single sentence. Digital history refers to the historians
who utilize computer and network technologies to put up information and data for making
available with a one-click option. Most of the time people are using different kinds of
technologies, such as virtual reality (VR), augmented reality (AR), and digital technologies,
to make all of them available for the future generations. You can access some of the popular
digital history projects through the following links accompanying the pictures.

™ -
Home | About | Contact | Friends My Account ENews Events 'r‘Blogs f G | @ | !

Select Language = | Powered by Google Translate

Historical Society
— — of Pennsylvania

Become a Friend | Donate | Shop | Plan Your Visit | Need Research?

Collections  History Online  Publications Education Search D -~

Home > Preserving American Freedom ﬁ

for SCHOLARS

Preserving American Freedom

for GENEALOGISTS &

COMMUNITY HISTORIANS
Preserving American Freedom, a HSP digital history project, provides 50 key documents for teaching about

the evolution of the idea of freedom and practices of liberty in U.S. history. This section links to Educator
for HISTORICAL & HERITAGE Taols for using these resources in the classroom,
ORGANIZATIONS

* Preserving American Freedom Unit and Lesson Plan

+ Organization of Preserving American Freedom Webasite

To help teachers better utilize Preserving American Freedom specifically and primary sources in general,
we have also created a series of short podeasts. These podcasts include interviews with the historians who
wrote contextual essays, hints from a classroom teacher on using the website, and guidelines for how
teaching with the website meets Common Core.

Source: https://hsp.org/preserving-american-freedom-0

Preserving American Freedom, a HSP digital history project
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Welcome to PhilaPlace! Featecred’
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Source: https://www.philaplace.org/
Philadelphia’s neighbourhood’s Project

m VECING
About the Project © Timeline/Chronology [ AFt/AH ‘ Oral Histoties

Search items Search

What makes a neighborhood?
What makes a neighborhood?

Source: https://omeka.hsp.org/s/puertoricanphillyexperience/page/homeinicio
Neighbors: Exploring 200 Years of Puerto Rican History in Philadelphia

1.1.5 Digital Tools for Research

Digital tools have changed the landscape of research across various discipline. It offers
capabilities for collecting, storing, analysing data very easily. We can collaborate in real
time from different parts of the world. Even we can disseminate knowledge so easily by
the help of using various applications and apps. We can use different tools for Data
collection and management, repositories, databases, storing memories, online surveys via
google form, citation management tools like Zotero, Mendeley End Note and so on.
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Research has been shifting its dimension as the amount of data is now huge, the
process of data analysis is digitalizing, and automated tools have been introduced to make
life easier.Reference management software is crucial for research like Zotero, EndNote,
and Mendeley. This tool helps manage citations and reviews. For data analysis we use data
analysis tools, which include SPSS, NVivo, and R. SPSS is used to analyze statistical data,
and NVivo is used for textual data. R is used for analyzing and visualizing. So qualitative
and quantitative data analysis is done with this software. Google Scholar, JSTOR, and
ResearchGate are used as a digital archive and database. We access research papers,
books, and journals from this.

Google Drive and Microsoft OneDrive should be basic skills for writing, storing, and
sharing documents across. Collaborative activities can be done through these tools.

Presentation tools like Canva, Prezi, and Microsoft PowerPoint should be given priority
because research and its findings need to be presented in an articulated and well-described
manner. Collaborative project management tools should be improved through tools like
Microsoft Teams, Slack, and Trello. The team can share its progress idea and task
distributions. Plagiarism is another issue in research, so we should use plagiarism detection
tools such as Turnitin, Copyscape, and Grammarly. ChatGPT, co-pilot, and DeepSeek can
be used to brainstorm ideas, planning, and analysis tasks and plan. We can train Al tools
on a specific topic and then ask them to analyze it based on recent learning and create
output accordingly.

1.1.6 Geographic Information Systems (GIS) in Humanities

Geographic Information Systems (GIS) is mostly used for geography. But it is also
being used by digital humanities scholars for data visualization and mapping their projects.
It consists of digital data and information that is visualized spatially by GIS software.
Interdisciplinary scholarship and liberal studies departments reject the boundaries of a
discipline and came up with Geographic Information Systems (GIS) technology for
collaborative research by taking the methods of geography and library science into
humanities.

1.1.7 Computer Applications in Literary Studies

As literary students, we are always thinking of reading a text. But today we are beyond
reading textual books. We are leading towards using computational tools and methods in
studying literature. Electric literature is one of the emerging fields of study for literary
students. Most of the text is being produced digitally. Many of the projects are available
in literary studies. We will share some of the projects in the below portion. Learners are
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advised and recommended to the projects given below the picture. Now we don’t use
physical dictionaries for finding new words and meanings. Digital humanities is one of the
key areas where you can get different literary projects based on literary figures and text.

BN Vi Lio-  Sciip- e Mulimoda- oy~ Ao~ .

The

Willa Cather Archive

The Willa Cather Archive is an ambitious endeavor to create a rich, useful, and widely accessible site for the study of

Willa Cather's life and writings.

— A%

A

Source https://cather.unl.edu/

The Willa Cather Archive

Advanced Search ~ About Donate

Iy ry e . —
The Walt Whitman Archive
Published Writings Literary Manuscripts Whitman's Life Letters Disciples Commentary Pictures, Sound, and Video

7727
Published Writings

i
News & Updates

February 2025

Disciples Two new editions of Leave:

mages and trz of related Whitman manuscripts. The new Back to top 1

Source:https://whitmanarchive.org/

1.1.8 Summing Up

Computers remain an integral part of day-to-day life in this 21st century. It is the main
component of ICT-based digital education, which is being rapidly spread in this post-covid
era. Govt. initiatives like SWAYAM, SWAYAMPRABHA, e-PG Pathshala, National Digital
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Library, popularly known as NDL (in collaboration with II'T Kharagpur), repositories like
Shodhganga, and LMS portals like NPTEL, etc., have brought the whole world of academia
inside the tiny computer/laptop screen where the aspiring students can explore everything
at their own pace. NEP 2020 has emphasized the importance of digital education, and
compulsory computer education has been included in all levels of school education. From
digital boards to virtual laboratories, education through computer and digital tools has
become integral to the Indian academic system. Similarly, in the case of humanities and
allied disciplines, computer literacy is playing a key role in shaping ideas. Through computer
and internet resources being accessed, data collection, compilation, and execution are
being performed. Digital applications like Skype, Zoom, Google Meet, etc., are becoming
reliable and cost-friendly alternatives to physical fieldwork where the focus area is
geographically located in some other part of the globe. Digital archives and museums are
standing just next in line with the physical museums where the artifacts and materials can
be preserved lifelong without the fear of decantation and physical damage. Computers and
all kinds of digital tools are being heavily used in all the branches of humanities and social
sciences, as they lead to almost error-free and unbiased results compared to the manual
studies. Thus, in this 21st century, computer applications and digital tools form the base of
humanistic research.

1.1.9 Comprehension Exercises

1. What is the role computer in enhancing research in different disciples?

2. How we can connect interdisciplinary in humanities and allied disciple research?

[98)

. Give a comprehensive overview of the relationship between information technology
and humanities.

Why are digital tools important in the study and research of humanities?
Comment on the usage of computers in our day-to-day lives.

Why is digital literacy important in elementary and in higher education?

A

Briefly describe the computational methods in humanities and social science research.
Comment on its merits and demerits.

8. How can database management be digitally performed?
9. Write a note on the importance of digital tools in research.

10. How does ICT play a key role in post-covid academia? Give a comprehensive
overview with a special reference to Indian academia and NEP 2020.
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1.1.9 Suggested Readings

Pfefferbaum, Adolph. The American Journal of Psychology, vol. 93, no. 4, 1980, pp. 740—
42. JSTOR, https://doi.org/10.2307/1422387. Accessed 21 Mar. 2025.

Raben, Joseph. “Computer Applications in the Humanities.” Science 228 (1985): 434 -
438.

Chapter 12: ICT and Digital Initiatives 12.1 Major Goals. dsel.education.gov.in/sites/default/
files/1Framework for%20 ICT.pdf.

NationalPolicy on Information and Communication Technology (ICT) in School Education.
2012, www.education.gov.in/sites/upload_files/mhrd/files/upload document/
revised_policy%20document%200fICT.pdf.
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Unit 2 O Basic Computer Operations and Operating
Systems

Structure

1.2.1 Objectives

1.2.2 Introduction

1.2.3 What is an Operating System?
1.14 Computer System Components
1.1.5 Functions of Operating System
1.1.6 History of Operating System
1.1.7 Types of Operating System
1.1.8 Mobile Operating System
1.1.9 Summing Up

1.1.10 Comprehension Exercises

1.1.11 Suggested Reading

1.2.1 Objectives

The objective of this unit is to give an outline of basic computer operations and its
operating system. Apart from that, the learner will be able to understand the ways in which
the computer operates its functionality. It also includes the components of the hardware and
software system of a computer.

1.2.2 Introduction

A computer is an integral part of our day-to-day life. There is no one who is not
benefiting from the uses of computers. Each of our aspects of life is predominantly determined
by it. As a learner of this course, one has to understand the basics of computer operating
systems. A computer works as a life machine with the help of some protocol by following
four operational cycles: input, processing, output, and storage. This is the process in which
it functions like a machine. A computer is also referred to as a system, which is run by a
collection of components that work together to accomplish a particular task as assigned by
its users. Now as a learner, you are able to understand the basic functionality of the
operating system and its uses as a layman. We are not discussing anything like a software
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engineer here. Our goal is to study and learn this unit as introductory learners of social
science and humanities students.

1.2.3 Whatis an Operating System?

It is not easy to define what is operating system. It is combination of software and
its application in general. Software, hardware and users are the key components of an
Operating System. An operating system consists of different components as shown in the
below picture. Learners are advised to see the picture for better understanding. All the
components are important for the functionality of an operating system. Different kinds of
applications, monitors, printers, hard drives, and mice and keyboards are essential. As
learners and users of computer desktops and laptops, we have seen all of these. It is
nothing new to us. The only thing is that we don’t keep our minds intact to understand the
functionality of an operating system. Let’s look at some technical terms related to OS, API,
CLI, and GUI. Here OS means operating system, in which we are able to see the total
functionality of a computer or any machine. API stands for the term application program
interface, by the help of which any program runs in a computer. CLI is called a command-
line interface, whereas we, the users, will give some commands from our ends, and
automatically it will be shown in the computer. GUI means a graphical user interface
through which any kind of visual interaction is made or represented in the final outputs of
a computer. So now as a computer user, you can understand the total process of an
operating system and what the components of a computer are. Each and everything is
important for the functionality of the computer operating system. We will understand it more
in the next stages of this particular unit.

. . Monitor
Ap;:-l»rr:a_tluns " 1
e | [ A !. Printer
. s HI
Hard Drive -l\ -

evboard

Picture is taken from: https://www.polytechnichub.com/operating-system-types/

#google vignette
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1.1.4 Computer System Components

You are requested to look at the below-mentioned graphs to understand different
exponents of computers. Today we can’t think of anything without the help of a computer.
In the picture given below you are able to see the different components of a computer
system, and previously, you read the basic components of a computer. Let’s look at the
different components of a computer.

Hardware Components:
Motherboard
Central Processing Unit (CPU)
Random Access Memory (RAM)
Storage Devices
Input Devices: keyboard, mouse, or microphone.
Output Devices: monitor, printer, or speakers.
Power Supply Unit (PSU)
Graphics Processing Unit (GPU
Computer Case

Software Components:
Operating System (OS) Windows, macOS, or Linux.
Application Software
System Software

o
| bahre *
W 3
-IF-II

v v v v v
- e =g

Image reference: https://www.geeksforgeeks.org/software-concepts/
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1.1.5 Functions of Operating System

The function of the operating system plays a vital role in making the system more
successful. You may look at the picture to understand the different functions of an operating
system. The operating system controls everything in a computer. It manages different
aspects like memory management, security of a computer, process management, device
management, file management, networking, coordination, and many more things. It is as if
all the controlling power of a computer lies within an operating system. In this way we can
understand the role of the operating system for running a computer. More potently, it
provides security and privacy to our system.

CONTROL

o
ACCOUNTING
Functions of
Operating
System

| COORDINATION Ve MANAGEMENT

Picture is taken from: https://www.jaroeducation.com/blog/demystifying-operating-systems.

1.1.6 History of Operating System

There is a long history of computer operating systems and their development. Initially
we don’t have any operating system. It runs through memory and the user interface. It
started during the 1940s, and during that time it was called the Z1 computer. During the
1960s, multiprogramming computers started, where multiple users are allowed to interact
with the OS. The first time during the 1970s, UNIX introduced an OS with a simplified
design and personal interface. This is the time when personal computers were launched.
Graphical user interfaces came at the time of the 1980s. The OS, like Apple Macintosh
and Microsoft Windows, is a momentum achievement during this period. We have seen the
wide expansion of OS in the name of LINUX, Windows, and Mac OS at the time of the
1990s. But recently, after the 2000s, it became more mobile friendly and cloud-based.
Most of the prominent OSs, like iOS and Android, dominate the total OS industry. Today
mobile operating systems have become part and parcel of our lives, and gradually they
have become more user-friendly.
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1.1.7 Types of Operating System

Operating systems can be categorized in different ways. First, look at the picture to
understand the category of different operating systems. Later on, we will explain each of
the categories in detail. These are very technical terms. We will try to understand it in very
simple language, and we need such information in detail as such. But as a layman, we try
to follow the basics of it.

Batch Operating System: In batch operating system users did not interact with OS
directly. Everything is done offline with different kinds of hardware elements. Users just give
their commands and rest of the task will be governed by the operators.

Time-Sharing Operating System: Here the case is different. In a time-sharing OS,
the user gives instructions directly to an OS. At the same time, the OS performs its duty
and executes multiple tasks at the same time. On the other hand, computer memory stores
these executions.

Distributed Operating System: A distributed operating system uses multiple CPUs
to serve multiple processes and a user interface. We know very well that computers
depend on their own memory and CPU. Both things are interconnected and interlinked to
perform any kind of task for an operating system. They perform the task over a shared
communication network, which is very complex to understand. As learners of social sciences
and humanities, we don’t understand such complex issues.

Network Operating System: A NOS is a most powerful operating system. It
communicates and functions through shared resources over a systematic network, which is
again very complex. It connects computers, printers, and even servers seamlessly through
different kinds of devices. It has a bigger role to play in case of data sharing, security, and
privacy of the users. There are many examples of network operating systems, such as
Microsoft Windows Server, Linux, and Novell NetWare. NOS allows different devices not
only to communicate with different software but also to go beyond that by sharing applications,
files, and hardware with the users.

Real-Time Operating System: A real-time operating system is considered to complete
the task with a very limited time limit. It has a deadline to complete the task. If the task
is not completed within the stipulated or assigned time, then it fails to achieve the task and
shows significant consequences. By the effect of that, it may result in critical failure or the
task is no longer relevant to be completed. This kind of operating system is used widely
in the cases where timing is an issue. For example, it is being used by medical companies,
industrial automation, and many more industry-related companies. There are two kinds of
real-time operating systems, namely hard real-time systems and soft real-time systems.
Learners are advised to know more about these two different real-time operating systems
so that they can get clearer ideas of them.
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Types of Operating System
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Picture ‘source’ - https://www.tpointtech.com/types-of-operating-systems

You can read more details in the following link-
https://techvidvan.com/tutorials/types-of-operating-system/
https://www.tpointtech.com/types-of-operating-systems

1.1.8 Mobile Operating System

Nowadays the most used operating system in the world is the mobile operating system.
It is a kind of operating system that has been used mostly in mobile smart phones, smart
watches, tablets, and many smaller personal devices. MOS has changed the landscape of
operating systems. Day by day it is becoming smaller and more user-friendly. Most of us
are aware of this fact. The MOS system runs different apps in their system to complete
the task very smoothly. The basic function of a mobile operating system is to perform the
duty of managing the basic functions of the smaller system in which they are built. It
simultaneously runs apps and controls its built-in memory and external memory as well.
This type of system provides an easy-to-use interface for its users. Thereby its users are
much more than the computers. Today millions of people use mobile operating systems
worldwide for their different kinds of features, which are very user-friendly, including data,
multitasking capabilities, calling, and internet facilities. MOS has a bright expansion in the
coming days.
Types of Mobile Operating System

1. Android

2. Apple Inc

3. Huawei develope-d HarmonyOS (Hongmeng OS in China)

4. KaiOS

5. Tizen

Learners are advised to read more on the above subject in the following link-https:/
/www.geeksforgeeks.org/what-is-a-mobile-operating-system/
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1.1.9 Summing Up

It covers the basics of the operating system and its user interface. The unit may be
connected with the next units as well. So far, we have discussed many things related to the
definition of operating system, computer system components, functions of operating system,
history of operating system, types of operating system, and mobile operating system.
Overall, you will see the different components of the computer operating system and its
functionality for performing different tasks on the computer. The global standard of operating
system is changing day by day. It is becoming smaller and more user-friendly. OS plays
a vital role in the realm of world computing systems that enable smooth interaction between
users, hardware, and software applications. It manages resources and works as an interface
to connect with hardware and software for multitasking performance. By the effect of the
technological landscape, which is ever changing, the operating system is evolving as a
standard user-friendly experience for users. We are moving forward and emerging
technological advancements such as artificial intelligence, virtual reality, and internet expansion.
Today, we are looking for efficiency, security, and user-friendliness.

1.1.10 Comprehension Exercises

What is operating System?
Explain the function of the operating system.
What is the full form of CPU?

What is your idea on real-time operating systems?

A e

What is the difference between a time-sharing operating system and a distributed
operating system?

6. What is the advantage of using a network operating system?
7. Explain different types of operating systems.

8. What is your idea on the history and growth of the development of the operating
system?

1.1.11 Suggested Reading / Web Reference

https://www.geeksforgeeks.org/software-concepts/
https://www.jaroeducation.com/blog/demystifying-operating-systems/
https://www.geeksforgeeks.org/what-is-a-mobile-operating-system/
https://www.tpointtech.com/types-of-operating-systems
https://techvidvan.com/tutorials/types-of-operating-system/
https://www.tpointtech.com/types-of-operating-systems
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Unit 3 0 Formatting Documents

1.3.1 Objectives
1.3.2 Introduction
1.3.3 Basic Text Formatting
1.3.3.1 Font Styles and Sizes
1.3.3.2  Bold, Italics, and Underline
1.3.3.3  Text Colour and Highlighting
1.34 Paragraph Formatting
1.3.4.1 Alignment (Left, Center, Right, Justify)
1.3.4.2  Line Spacing and Paragraph Spacing
1.3.4.3 Indentation and Tabs
1.3.5 Styles and Themes
1.3.5.1 Applying and Modifying Styles
1.3.5.2  Using Built-in Themes
1.3.5.3  Customizing Styles for Consistent Formatting
1.3.6 Page Layout and Design
1.3.6.1 Margins and Orientation (portrait vs. landscape)
1.3.6.2 Page Breaks and Section Breaks
1.3.6.3 Headers, Footers, and Page Numbering
1.3.7 Lists and Bullets
1.3.7.1 Creating and Formatting Vullet Lists
1.3.7.1 Creating and Formatting Numbered Lists
1.3.7.1  Customizing List Styles
1.3.8 Tables and Columns
1.3.8.1 Inserting and Formatting Tables
1.3.8.2  Adjusting Table Layout and Design
1.3.8.3  Using Columns for Text Layout
1.3.9 Graphics and Visuals
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1.3.9.1 Inserting Images and Shapes

1.3.9.2  Adjusting Image Properties and Layout

1.3.9.3  Using Smart Art and Charts
1.3.10  References and Citations

1.3.10.1 Inserting and Formatting Footnotes and Endnotes

1.3.10.2 Creating and Managing a Bibliography

1.3.10.3 Using Citation Tools and Reference Styles (APA, MLA, etc.)
1.3.11 Review and Finalizing

1.3.11.1 Proofreading Tools (Spell Check, Grammar Check)

1.3.11.2 Track Changes and Comments for Revisions

1.3.11.3 Preparing the Document for Printing or Sharing (PDF, Print
Settings)

1.3.12 Summing Up
1.3.13  Comprehension Exercises

1.3.14 Suggested Readings

1.3.1 Objectives

In this unit, we will explore why formatting documents is important. You will learn how
to adjust page layouts and margins to create well-organized and visually pleasing documents.
We will cover how to choose the right fonts and sizes for clear and effective writing. You
will also gain skills in using line and paragraph spacing to improve readability and organize
content logically. We will discuss how to use different types of headings and subheadings
effectively, as well as how to apply bullets for structured information. Overall, this unit will
help you easily understand the basic rules of document formatting.

1.3.2 Introduction

Formatting documents is an essential skill for students to presentinformation clearly and
professionally. As we know the skill of proper formatting enhances readability and helps
organize content effectively, making it easier for readers to follow your ideas. Basic formatting
includes setting margins, choosing appropriate fonts, adjusting line spacing, and using headings
and lists to structure your document. Additionally, features like page numbers, headers, and
footers contribute to a polished appearance. By mastering these simple techniques, you can



NSOU e NSE-EG-03 27

create documents that look professional and are easy to read, whether you are writing an
essay, report, or presentation.

1.3.3 Basic Text Formatting

1.3.3.1. Font Styles and Sizes

o Font Styles: You need to choose a font style that is easy to read and appropriate
for your document. The most commonly used fonts for academic and professional
documents include Times New Roman, Arial, and Calibri. It is suggested to go for
Times New Roman for your current needs.

® Font Sizes: You can use a standard font size for the main body of text, typically
12 points. As we know, titles and headings can be larger to stand out, and for
that,you are being advised to go for 14 to 16 points.

Home Insert Draw Design Layout References Mailings Review View Q Tell me

L‘E‘, Times New... & 12 v A" A Aav | A o =

Paste . Font Collections > =
P

Calibri Light

(Headings)
Calibri (Body)
Times New Roman Times New Roman

Palatino Linotype
: Regular

Talic
Abadi Bold
Auad MU ’ Bold Italic
Academy Engraved LET
{>ADLaM
€1 Agency 1B
Aharoni
Al Bayan
Al Tarikh
|> Alasassy Caps
Idhabi
LGERIAN
<> Amasis MT Pro
American Typewriter
Andale Mono
Angsana New
&> AngsanaUPC
€1° Aparajita

Apple Braille

Figure 1. Choosing Fonts
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1.3.3.2 Bold, Italics, and Underline

® Bold: To highlight your key points, use bold to emphasize important words or
headings. This can help draw attention to key points or sections. Go to the top of
the home page, find B and click, or simply click CTRL+B for Bold.

@ Italics: Italics are used for emphasis, to denote titles of works (like books and
films), or to highlight foreign words and phrases. Go to the top of the home page,
find 7 and click, or simply click CTRL+I for ltalics.

® Underline: Underlining is less commonly used in digital documents but can be
useful for emphasis in handwritten or printed materials. It is often used for hyperlinks
in digital documents.Go to the top of the home page, find U and click, or simply
click CTRL+U for Underline.

1.3.3.3. Text Colour and Highlighting

® Text Colour: Changing text colour can be used to emphasize certain words or
sections. Use contrasting colours that are easy to read against the background.Change
colours only when extremely necessary.

@ Highlighting: Highlighting is used to draw attention to specific parts of the text.
Use it to mark important sections, similar to how you might use a highlighter pen
in a printed document. Choose colours that are easy on the eyes, like light yellow
or blue.

Figure 2: Highlighting
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1.3.4 Paragraph Formatting

1.3.4.1 Alignment

® Left Alignment: This is the most common alignment for text in documents. It aligns
the text evenly along the left margin, creating a clean and organized appearance.
Left alignment is ideal for most academic and professional writing.

@ Center Alignment: Center alignment positions text in the middle of the page. It is
typically used for titles, headings, and sometimes for short lines of text like quotes
or poetry.

® Right Alignment: This alignment aligns text along the right margin, leaving the left
margin uneven. Right alignment is less commonly used but can be effective for
specific purposes, such as aligning dates or creating a signature line.

o Justify Alignment: Justified text aligns evenly along both the left and right margins,
creating a clean block of text. While it provides a neat appearance, it can sometimes
create uneven spacing between words, so it should be used carefully in documents
where readability is crucial. The present Unit is written in Justified Alignment.

1.3.4.2 Line Spacing and Paragraph Spacing

® Line Spacing: Line spacing refers to the amount of space between lines of text.
Common options include single spacing, 1.5 spacing, and double spacing. Double
spacing is often required for academic papers to enhance readability and allow
room for comments or edits.

® Paragraph Spacing: Paragraph spacing is the space before and after a paragraph.
Adding space between paragraphs can improve readability and help distinguish
between sections of text. Standard paragraph spacing is typically 6 to 12 points
after a paragraph.

1.3.4.3 Indentation and Tabs

@ Indentation: Indenting the first line of a paragraph helps visually separate paragraphs
and can make a document easier to read. Standard indentation is usually 0.5 inches
or one tab space.

@ Tabs: Tabs are used to create consistent spacing and alignment within a line of text.
They are useful for creating lists, aligning text, or setting up tables. 1.5. Styles and
Themes
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1.3.5 Styles and Themes

1.3.5.1 Applying and Modifying Styles

Styles include font, size, colour, alignment, spacing, and other formatting elements.
Most word processors have a “Styles” pane or menu where you can select and apply
styles such as “Title,”’Heading 1,””’Normal,” etc. You can modify existing styles to better
suit your document’s needs. To modify a style, right-click on the style in the styles menu
and select “Modify.” From there, you can adjust the font, size, colour, alignment, and other
attributes. You can easily change styles by automatically applying a specific style to your
document.

1.3.5.2 Using Built-in Themes

To apply a theme, go to the “Design” or “Page Layout” tab in your word processor,
then choose from the available themes. Themes can change the appearance of styles,
colours, and overall document design in one click.Make sure that your selected themes are
simple.

1.3.5.3 Customizing Styles for Consistent Formatting

If the built-in styles don’t meet your needs, you can create custom styles. Go to the
styles menu, select “Create a Style,” and define your custom settings. Name your style and
save it for future use.This is particularly useful for long documents, as it allows for quick
and uniform changes.If you frequently use the same styles, consider saving them as part of
a template or theme to use in future documents.

1.3.6 Page Layout and Design

1.3.6.1 Margins and Orientation

Margins: Margins are the blank spaces around the edges of a page. Standard margin
settings are usually 1 inch on all sides, but they can be adjusted based on specific document
requirements.

Orientation:
@ Portrait Orientation: This is the default orientation for most documents, where the

page is taller than it is wide. It is ideal for standard text documents, essays, and
reports.

® Landscape Orientation: In landscape orientation, the page is wider than it is tall.
This orientation is useful for wide tables, charts, and presentations.
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To adjust margins and orientation, go to the “Page Layout” or “Layout” tab in your
word processor. You can select predefined options or customize them as needed.

1.3.6.2 Page Breaks and Section Breaks

Page Breaks:Page breaks are used to end a page and begin a new one. This is useful
for starting a new chapter, section, or topic on a fresh page. To insert a page break, place
your cursor where you want the break to occur and select “Page Break” from the “Insert”
or “Layout” menu.

Section Breaks:Section breaks divide a document into sections, allowing you to
apply different formatting or layouts to each section. For example, you can have different
headers or footers in each section. There are several types of section breaks:

® Next Page: Starts a new section on the next page.
o Continuous: Starts a new section on the same page.
o Even/Odd Page: Starts a new section on the next even or odd page.

® Inserting Section Breaks:Go to the “Layout” or “Page Layout” tab and select
“Breaks,” then choose the type of section break you need.

1.3.6.3 Headers, Footers, and Page Numbering

® Headers and Footers:Headers appear at the top of every page, while footers
appear at the bottom. They are used to include information such as the document
title, author’s name, or page numbers.

® Creating Headers and Footers:Go to the “Insert” tab and select “Header” or
“Footer.” You can choose from predefined layouts or create a custom one. To edit
the header or footer, double-click the top or bottom of the page.

® Page Numbering: Adding page numbers is essential for longer documents to help
readers navigate. Page numbers can be added in headers or footers and formatted
as needed (e.g., top right, bottom center).

® Inserting Page Numbers:Go to the “Insert” tab, select “Page Number,” and
choose where you want the numbers to appear. You can also format the numbering
style (e.g., Arabic, Roman numerals).
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1.3.7 Lists and Bullets

1.3.7.1 Creating and Formatting Bullet Lists

Bullet lists are used to present information in a concise and organized manner. They
are ideal for listing items, ideas, or steps without implying a specific order.To create a bullet
list, select the text you want to format as a list, then go to the “Home” tab and click on
the “Bullets” button. This will convert your text into a bulleted list. You can change the bullet
style by clicking the dropdown arrow next to the “Bullets” button. Choose from standard
bullet shapes like dots, squares, or arrows, or select “Define New Bullet” to use symbols
or images.

1.3.7.2 Creating and Formatting Numbered Lists

To create a numbered list, select the text you want to format, then go to the “Home”
tab and click on the “Numbering” button. This will convert your text into a numbered list. To
change the numbering style, click the dropdown arrow next to the “Numbering” button.
You can choose from Arabic numerals (1, 2, 3), Roman numerals (I, II, III), letters (A,
B, C), and more. You can also set the numbering to start at a specific number.

1.3.7.3 Customizing List Styles

To create a custom bullet style, go to the “Define New Bullet” option under the bullet
dropdown menu. You can select a symbol, image, or custom character as your bullet.For
numbered lists, use the “Define New Number Format” option under the numbering dropdown
menu. Here, you can choose different number formats, add text before or after numbers,
and adjust the alignment.To create a multilevel list, select your list and click on the “Multilevel
List” button in the “Home” tab. Choose a style or define a new one to suit your needs.

1.3.8 Tables and Columns

1.3.8.1 Inserting and Formatting Tables

Tables are useful for organizing data in rows and columns, making it easy to compare
information. To insert a table, go to the “Insert” tab, click on “Table,” and select the number
of rows and columns you need by dragging over the grid.Once a table is inserted, you can
format it to improve readability and appearance. Click on the table to access the “Table
Design” and “Layout” tabs. Here, you can apply various styles, colours, and borders to
your table.Use the “Table Styles” gallery in the “Table Design™ tab to quickly apply a
predefined style to your table. Styles include options for headers, banded rows, and
alternating colours, which enhance the visual appeal and readability of your table.
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1.3.8.2 Adjusting Table Layout and Design

® Resizing Rows and Columns:You can adjust the size of rows and columns by
clicking and dragging the borders. For precise adjustments, go to the “Layout” tab
and use the options for “Row Height” and “Column Width.”

® Merging and Splitting Cells: To merge cells (combine them into one), select the
cells you want to merge, then click “Merge Cells” in the “Layout” tab. To split a
cell, click “Split Cells” and specify the number of rows and columns you want to
create within the selected cell.

® Aligning Text:You can align text within table cells to the left, center, or right, and
adjust vertical alignment to the top, middle, or bottom of cells. These options are
available in the “Layout” tab under “Alignment.”

1.3.8.3 Using Columns for Text Layout

Columns are useful for creating newspaper-style layouts or organizing text in a more
readable format. To add columns, go to the “Layout” or “Page Layout” tab and click
“Columns.” Choose the number of columns you want (e.g., one, two, three) or select
“More Columns” for additional options.You can adjust the width and spacing of columns
by selecting “More Columns” from the “Columns” menu. Here, you can specify the exact
width of each column and the spacing between them.Use column breaks to control where
text flows from one column to the next. Place your cursor where you want the break and
go to the “Layout” or “Page Layout” tab, then select “Breaks” and choose “Column.”

1.3.9 Graphics and Visuals

1.3.9.1 Inserting Images and Shapes

To insert an image, go to the “Insert” tab and select “Pictures.” You can choose from
files on your computer or from online sources. Once inserted, you can resize and move the
image as needed.To add shapes like rectangles, circles, or arrows, go to the “Insert” tab
and click on “Shapes.” Choose the shape you want and click on your document to draw
it. Shapes can be used for emphasis, diagrams, or visual organization.
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Figure 5: Inserting Images

1.3.9.2 Adjusting Image Properties and Layout

® Resizing Images: To resize an image, click on it to reveal sizing handles. Drag the
corners to maintain proportions or the sides to adjust width or height. Hold the
“Shift” key while dragging to keep the image’s aspect ratio.

® Cropping Images:To crop an image, select it and go to the “Picture Format” tab,
then click “Crop.” Adjust the cropping handles to remove unwanted areas and click
outside the image to apply.

1.3.9.3 Using SmartArt and Charts

SmartArt is useful for creating diagrams and visual representations of ideas. To insert
SmartArt, go to the “Insert” tab and select “SmartArt.” Choose from various types like
lists, processes, or hierarchies. Enter your text into the SmartArt graphic to customize it. To
add charts, go to the “Insert” tab and click “Chart.” Choose the chart type that best
represents your data, such as bar, line, or pie chart.Customize charts by selecting them and
using the “Chart Tools” tabs (“Design” and “Format”). You can change chart styles, colours,
and layout options.
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1.3.10 References and Citations

1.3.10.1 Inserting and Formatting Footnotes and Endnotes

o Inserting Footnotes:Footnotes provide additional information or citations at the
bottom of the page. To insert a footnote, place your cursor where you want the
footnote number to appear in the text, go to the “References” tab, and click “Insert
Footnote.” The footnote number will be automatically inserted, and you can type
your footnote text at the bottom of the page.

@ Inserting Endnotes:Endnotes are similar to footnotes but appear at the end of the
document. To insert an endnote, place your cursor where you want the endnote
number, go to the “References” tab, and click “Insert Endnote.” The endnote
number will be added to your text, and you can type your endnote content at the
end of the document.

1.3.10.2 Creating and Managing a Bibliography

® Creating a Bibliography:A bibliography lists all sources referenced in your
document. To create one, go to the “References” tab, click “Bibliography,” and
choose a format. The bibliography will be generated based on the sources you have
cited in your document.

® Managing Sources:To manage your sources, use the “Manage Sources” button
in the “References” tab. Here, you can add new sources, edit existing ones, or
delete sources. Ensure that all the information about your sources is accurate and
complete.

@ Updating the Bibliography:After adding or modifying sources in your document,
update the bibliography by clicking on it and selecting “Update Citations and
Bibliography.” This ensures that all your references are correctly listed and formatted.

1.3.10.3 Using Citation Tools and Reference Styles (APA, MLA, etc.)

e Citation Tools: To use these tools, go to the “References” tab and select “Citations
& Bibliography.” You can add sources, insert citations, and choose a citation style.

® Reference Styles:Different fields and institutions use various citation styles. Common
styles include:

< APA (American Psychological Association): Used in social sciences. Citations
include the author’s last name, first initial, year of publication, title, and source.

< MLA (Modern Language Association): Used in humanities. Citations include
the author’s name, title of the work, publisher, and publication date.
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< Chicago/Turabian: Used in history and some other disciplines. It offers two
systems: Notes and Bibliography and Author-Date.

@ Applying a Citation Style:To apply a citation style, go to the “References” tab,
select “Style,” and choose your preferred style (e.g., APA, MLA, Chicago). The
citation tools will format your references according to the selected style.

® Inserting Citations:To insert a citation, place your cursor where you want the
citation to appear, click “Insert Citation,” and select a source from your list. The
citation will be formatted according to the selected style.

Type of Source [Book

Bibliography Fields for MLA
Author: |

Corporate Author:

Example: Dickens, Charles; Hemingway, Ernest
Show all bibliography fields

Type of Source: Placeholder1 Cancel oK
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Figure 6: References

1.3.11 Review and Finalizing

1.3.11.1 Proofreading Tools

® Spell Check:Spell check helps identify and correct spelling errors in your document.
To use spell check, go to the “Review” tab and click on “Spelling & Grammar.”
The tool will scan your document for spelling mistakes and suggest corrections.

® Grammar Check:Grammar check highlights grammatical errors and provides
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suggestions for improvement. In the “Review” tab, click on “Spelling & Grammar”
to perform a grammar check. Or, you can simply apply the Grammarly app.

® Proofreading Tip:Reviewing a printed draft can help you notice errors that might
be overlooked on a screen.

1.3.11.2 Track Changes and Comments for Revisions

® Tracking Changes:The “Track Changes” feature allows you to keep track of all
edits and modifications made to a document. To activate it, go to the “Review” tab
and click “Track Changes.” This feature will highlight insertions, deletions, and
formatting changes, making it easy to review revisions.

® Adding Comments:Use comments to provide feedback or notes within the
document. Highlight the text where you want to add a comment, go to the “Review”
tab, and click “New Comment.” Type your comment in the sidebar that appears.
Comments can be used for collaborative editing or personal reminders.

® Reviewing Changes and Comments:Review changes and comments by navigating
through them using the “Previous” and “Next” buttons in the “Review” tab. You can
accept or reject changes and resolve comments as you review the document.

1.11.3 Preparing the Document for Printing or Sharing

® Saving as PDF:Converting your document to a PDF ensures that formatting remains
consistent when shared. To save as a PDF, go to “File,” select “Save As,” choose
the location, and select “PDF” from the “Save as type” dropdown menu. PDFs are
ideal for sharing and printing as they preserve the document’s layout.

® Print Settings: Adjust print settings to ensure your document prints correctly. Go
to “File” and select “Print” to access print settings. Here, you can choose the
printer, number of copies, page range, and print layout options.

® Preparing for Online Sharing:If sharing online, ensure your document is in a
widely accessible format and check that all hyperlinks and interactive elements
work correctly. Review the document for any personal or sensitive information that
should be removed before sharing.

® Final Review:Before finalizing, perform a last review to ensure all changes are
correct, formatting is consistent, and there are no remaining errors. Verify that the
document meets any specific guidelines or requirements for its intended purpose.
You are good to go.
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1.3.12 Summing Up

This module on document formatting and preparation covers essential aspects for
creating professional and well-organized documents. It includes basic text formatting (fonts,
styles, colours), paragraph formatting (alignment, spacing, indentation), and advanced features
like styles and themes, page layout (margins, orientation), and lists. It also addresses
inserting and formatting tables, shapes, and charts, as well as managing references with
footnotes, endnotes, and bibliographies using various citation styles. Finally, it emphasizes
reviewing and finalizing documents with proofreading tools, tracking changes, and preparing
for printing or sharing, ensuring your document is clear, consistent, and ready for distribution.

1.3.13 Comprehension Exercises

1. Save a document in different formats (e.g., PDF, DOCX) and adjust print settings.
(Prepare the document for printing or online sharing, ensuring it meets formatting
and layout standards.)

i.. Insert footnotes and endnotes into a research document. (Format them correctly
and ensure they match the citation style used.)

ii. Insert images and shapes into a document. (Resize, crop, and adjust the layout of
images.)

1.3.14 Suggested Readings:
1. Strunk, William, Jr., and E. B. White. The Elements of Style. Chump Change,
2018.
il. The Chicago Manual of Style. University of Chicago Press, 2017.
. MLA Handbook. Modern Language Association of America, 202.

v. Publication Manual of the American Psychological Association. American
Psychological Association, 2020.



40 NSOU ¢ NSE-EG-03

Unit 4 O Proofreading

14.1 Objectives
14.2 Introduction
1.4.3 Proofreading Steps in Microsoft Word

1.4.3.1 Language Settings
1.4.3.2  Spelling and Grammar Checking
1.4.3.3  Use of Thesaurus and Dictionary
1.4.4 Find out Proofreading Options
14.5 Advanced Proofreading Techniques
1.4.6 Check Entire Document
1.4.7 Suggestions
14.8 Summing Up
149 Comprehension Exercises

1.4.10 Suggested Reading

1.4.1 Objectives

The main objectives of proofreading in Word are to make sure the document is perfect
and easy to understand. This means carefully checking for and fixing mistakes in spelling,
grammar, and punctuation. It also involves making sure the document is consistent in its
formatting, style, and tone. Additionally, proofreading helps to ensure that the information
in the document is accurate and trustworthy. It’s also important to check that the document
does not contain any copied work without permission, and that it follows the rules of a
specific style guide if necessary. By doing all these things, proofreading helps to create a
high-quality document that is professional, clear, and effective. We will learn how to carefully
review and improve writings to cut down on mistakes and changes.

1.4.2 Introduction

Proof reading means correcting mistakes in a document, typescript, or printed copy
before it is published. It involves carefully reading and checking written work for mistakes
in syntax, grammar, punctuation, style, consistency, format, and style in order to make sure
it is correct, clear, and of high quality. This includes finding and fixing typos, grammatical
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errors, punctuation mistakes, and inconsistencies in style, format, and tone, as well as
making sure the text is factually correct and free of ambiguities, contradictions, and other
errors, which improves the credibility, readability, and overall effectiveness of the written
communication.

Proofreading in Microsoft Word involves using different tools and features to look over
and improve written text. These include the Spell & Grammar Check tool to find spelling,
grammar, and punctuation mistakes, the Thesaurus to suggest other words and phrases, the
Dictionary to check word meanings and usage, the Find and Replace tool to find and fix
specific errors, the Track Changes tool to keep track of and manage changes, and the
Readability Statistics tool to analyze and improve text clarity and readability, all with the
goal of making sure the document is error-free, polished, and useful.

1.4.3 Proof Reading Steps in Microsoft Word

Microsoft Word features a built-in proofreading mechanism and an array of tools
designed to ensure error-free documents. Mastering these tools is essential, and learning
how to use them step-by-step can significantly enhance your writing and editing skills.

1.4.3.1 Language Settings
To verify your language preferences:
Select the document by pressing the Ctrl+A key combination.
Click to the “Review” section.

Select “Set Proofing Language” from the “Language” navigation menu. The Language
field will be displayed as a result.

Select the language according to your preference. Indian students can choose “English
(India).”
You shouldn’t click the “Do not check spelling and grammar” button if you don’t want
to use it.
HOME DESIGN PAGI !
ALY A

Spelling & Defin

Grammar

The first step in proofreadin;
accurate, professional, and c
positively on the author and o ics
spelling and grammar are crucial to avoid serious consequences.
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1.4.3.2. Spelling and Grammar Checking

The first step in proofreading is checking spelling and grammar. This ensures a document
is accurate, professional, and clear. Error-free documents are easier to read and reflect
positively on the author and organization. In fields like law, medicine, and finance, accurate
spelling and grammar are crucial to avoid serious consequences. Students should follow the
following steps to check spelling and grammar in a word file.

Automatic Spelling and Grammar Checking
1. Open your document: Open the Word document you want to check.

2. Enable automatic checking: Go to Review > Spelling & Grammar. Make sure the
Check spelling as you type and Check grammar as you type options are selected.

3. Word will underline errors: As you type, Word will underline spelling and grammar
errors with a red or green squiggly line.

G oMe  INSERT  DESIGN  PAGEL

ABC = ABC £y @

v IR EA &5 ay ;
Spelling & Define Thesaurus Word  Transia
Grammar Count -

rrrrrrrr

documnt

document <
T see definitions:
Sign in Using Your Microsoft Account

Manual Spelling and Grammar Checking

1. Open your document: Open the Word document you want to check.

2. Go to Review tab: Click on the Review tab in the ribbon.

3. Click on Spelling & Grammar: Click on the Spelling & Grammar button.

4. Word will check the document: Word will check the entire document for spelling
and grammar errors.

5. Review and correct errors: Review the errors Word has found and correct them as
needed.

1.4.3.3. Use of Thesaurus and Dictionary

The Thesaurus and Dictionary are crucial tools in the proofreading process, enabling
individuals to refine their writing, enhance clarity, and ensure accuracy. The Thesaurus helps
to expand vocabulary, providing alternative words and phrases to convey intended meanings,
while the Dictionary ensures that words are used correctly, facilitating precise communication.



NSOU e NSE-EG-03 43

By leveraging these tools, proofreaders can detect and correct errors, improve sentence
structure, and enhance the overall quality of the document, ultimately producing a polished
and professional final product. Students should follow the following steps to use these tools
in a word file.

Using the Thesaurus

1. Select the word: Select the word you want to find synonyms for.

2. Go to Review tab: Click on the Review tab in the ribbon.

3. Click on Thesaurus: Click on the Thesaurus button in the Proofing group.

4. View synonyms: Word will display a list of synonyms for the selected word.

5. Choose a synonym: Select a synonym from the list to replace the original word.

The first step in proofreading is checking spelling and
accurate, professional, and clear. Exor-free docu
positively on the author and Srganization.
spelling and grammar are crucial to avoid

Using the Dictionary

1. Select the word: Select the word you want to define.

2. Go to Review tab: Click on the Review tab in the ribbon.

3. Click on Dictionary: Click on the Dictionary button in the Proofing group.
4. View definition: Word will display the definition of the selected word.

5. Learn more: You can also click on the Learn more link to access additional information
about the word.

1.4.4. Find out Proofreading Options
Students should check their ‘Proofing Options’ by following steps:
Click on ‘File’ then click on ‘Options’ then you can see the “Word Options’ window.

From the left side of the window, you can see the ‘Proofing’ option. Click on it. Click
the options that you need. Click the first four boxes under “When correcting spelling and
grammar in word’ Then click ‘ok’.
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In the section titled ‘Exceptions for’, ensure that spelling and grammar errors are not
hidden.

FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW ZOTERO

ABC E = ABC | Word Options ? X
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Advanced Ignore words that contain numbers

Ignore Internet and file addresses
Flag repeated words

Custemize Ribbon

Quick Access Toolbar [ Enforce accented uppercase in French
Add-Ins [ Suggest from main dictionary only
Trust Center Custom Dictionaries...

French modes: | Traditional and new spellings |+

Spanish modes: | Tuteo verb forms only v
When correcting spelling and grammar in Word

Check spelling as you type

Mark grammar errors as you type

Frequently confused words

Check grammar with spelling
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Writing Style: |Grammar Only |+ Settings...

Recheck Document
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1.4.5 Advanced Proofreading Techniques

Add a comment

The “Add a Comment” section is an invaluable tool when proofreading a document,
research paper, manuscript, or any project. This feature enables you to add your comments,
suggestions, questions, or arguments in a non-intrusive manner, allowing authors or
collaborators to review and address your feedback.

® By using the “Add a Comment” section, you can:
Provide constructive feedback on content, structure, and style

Ask questions or seek clarification on unclear points

[ ]

[ ]

@ Offer suggestions for improvement or alternative approaches

® Engage in a dialogue with authors or collaborators to discuss revisions
o

Track changes and revisions made to the document
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This feature is particularly useful when working on collaborative projects, as it facilitates
open communication and ensures that all stakeholders are informed and aligned throughout
the review and revision process.

After checking the document, you want to add your comment. For this you need to
select a word or sentence or paragraph, then go to “Review” then go to “New Comment”.
At the right side of the document, an option will appear to add your comment.
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The first step in proofreading is checking spelling and grammar. This ensures a document is

accurate, fe 1. and clear. Error-fr are easier to read and reflect Microsoft account 9 minutes ago b}
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positively on the author and organization. [In fields like law, medicine, and finance, accurate
spelling and grammar are crucial to aveid serious consequences)

Track Changes

The Track Changes feature in MS Word is an important tool that enhances collaboration,
version control, and editing efficiency. By giving chance multiple users to contribute to a
document, tracking changes, and attributing them to individual users, this feature makes
easy the review and revision process. Additionally, users can add comments and feedback,
promoting clear communication and transparency. With Track Changes, users can streamline
their workflow, reduce editing time, and maintain a comprehensive record of document
revisions. Steps of Track Changes:

Click “Review” — “Track Changes”.

FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW ZOTERO Microsoft account t v
ABC =] ABC x €« > =y, G Al Markup T ™
IE EH [P AP P 7z = ‘
- & ) Show Markup =
Define Thesaurus Word T New Delete Previous Next o Track Compare Restrict
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1.4.6 Check Entire Document

Proofreading a document involves a comprehensive review that goes beyond mere
spelling, punctuation, and grammar checks. A thorough proofread requires a meticulous
examination of the entire document, including:

@ Visual elements: font style, font size, bold, italics, underline, and strike-through
text

@ Text formatting: alignment of lines, line and paragraph spacing, indentations, and
margins
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Page layout: page orientation, page size, and section breaks

Headings and subheadings: consistency in formatting, numbering, and hierarchy

[ ]
[ ]
® Tables and figures: accuracy, clarity, and consistency in formatting and labeling
@ Captions and footnotes: accuracy, clarity, and consistency in formatting and content
@ Consistency: consistency in formatting, style, and tone throughout the document
[ ]

Accuracy: accuracy of facts, figures, and data, as well as consistency in formatting
and presentation

® Readability: clarity, concision, and overall readability of the content

By carefully reviewing these elements, you can ensure that your document is not only
error-free but also visually appealing, well-organized, and effective in communicating its
message.

1.4.7 Suggestions

Read slowly and each word

Proofreading is a meticulous and time-consuming process that demands attention to
detail. It involves carefully examining every word, phrase, punctuation mark, grammatical
structure, and content element to ensure accuracy and consistency. To proofread effectively,
it’s essential to have a clear and focused mind, free from distractions, stress, and fatigue.

Divide the text into smaller sections

Breaking down the text into smaller sections simplifies the proofreading process. Focus
on one section at a time, reading it carefully before taking a break. This approach helps
you avoid feeling overwhelmed and allows you to concentrate more effectively on each
section. This technique is especially useful for proofreading lengthy documents, including
research papers and projects.

Read in reverse order

This proofreading technique is highly effective for detecting spelling errors. It involves
working backwards through your text, starting with the last word and examining each one
individually until you reach the beginning. During this process, focus solely on the spelling
of each word. Additionally, many proofreaders recommend reading the work in reverse
order, sentence by sentence. This approach helps you evaluate each sentence independently,
detached from the broader context. It’s a useful way to pinpoint grammatical errors and
refine your writing.
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Keep track of the errors you tend to repeat

Regular proofreading helps you recognize your writing patterns, including frequent
mistakes. By acknowledging your weaknesses, you can develop strategies to overcome
them. When you know your common mistakes, you can avoid them while writing. To
improve your proofreading skills, keep reference materials like style guides and grammar
rules handy. Verify any uncertain areas to expand your knowledge. With time and practice,
your writing skills will refine, and you’ll become a more effective proofreader.

Circle punctuation marks

Although it may appear meticulous, circling each punctuation mark is a highly effective
technique for detecting errors. This method requires you to scrutinize every mark individually,
prompting you to verify its correct usage.

1.4.8 Summing Up

Microsoft Word is an excellent platform for effortless proofreading, but it’s essential
to have a good grasp of its features and tools. Before diving into proofreading, it’s crucial
to understand how to utilize MS Word’s important tools, which have been discussed in
detail in the preceding sections. Students can leverage these tools to ensure their documents
are error-free. However, it’s vital to remember that relying solely on these tools can lead
to overlooked mechanical errors. Therefore, a manual review at the end of the proofreading
process is highly recommended to catch and correct any remaining errors.

Apart from MS Word’s built-in proofreading tools, several other useful resources are
available, including:

® Grammarly: A popular writing assistant that offers advanced grammar, spelling, and
punctuation checks.

® Quillbot: A comprehensive writing tool that provides grammar, syntax, and style
suggestions.

® ProWritingAid: A robust writing tool that offers grammar, spelling, and punctuation
checks, as well as suggestions for improving writing style and clarity.

® Ginger: A writing assistant that provides grammar, spelling, and punctuation checks,
as well as language translation and rephrasing suggestions.

By combining MS Word’s proofreading tools with these additional resources, users
can ensure their documents are polished, accurate, and error-free.
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1.4.9 Comprehension Exercises

1. Proofread the below passage and correct the errors.

The first step in proofreading is chekingspeling and grammar. This ensures a
documnt is accurate, professional, and clear! Error-free documents are easier
to read and reflect positively on the author between organization? In fields like
law; medicine: and finance, accurate spelling and grammar are crucial to avoid
serious consequences. Students should folow the folowing steps to check
speling and gramar in a word file.

2. What errors can you identify in the above paragraph?
3. Identify incorrect spelling of the following passage:

Microsoft Word fetures a built-in proofreading mehanism and an aray of tols
designed to ensure eror-free documents. Mastering these tols is essential, and
lerning how to use them stp-by-step can signficantlyenhnce your writing and
editing skils.
4. Read the following paragraph and identify areas where the writing could be improved
for clarity and coherence. Provide specific suggestions for revision.

The influence of television serials on society is profound, extending to fashion
trends, styles, behavior, and the perpetuation of political, religious, and patriarchal
ideologies. Notably, these serials play a significant role in shaping and redefining
traditional gender constructs, often reinforcing dominant patriarchal narratives
and their visual representations.

5. Identify and correct the grammatical errors in the following paragraph. Explain the
rules or principles that guided your corrections.

The Thesaurus and Dictionary is crucial tools in the proofreading process,
enabling individuals to refine their writing, enhance clarity, and ensure accuracy.
The Thesaurus help to expands vocabulary, providing alternative words and
phrases to convey intended meanings, while the Dictionary ensures that words
is used correctly, facilitating precise communication. By leveraging these tools,
proofreaders is detect and correct errors, improve sentence structure, and
enhance the overall quality of the document, ultimately producing a polished
and professional final product.
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Unit 5 3 Introduction to Basic Software
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2.5.12 Suggested Readings

2.5.1 Objectives

Software plays a crucial role in the functionality of computers, enabling users to perform
various tasks efficiently. This unit explores the significance of basic software, including
operating systems, productivity tools, communication software, web browsers, and security
applications. The objective is to highlight how these software types enhance system
performance, streamline work processes, facilitate digital communication, and ensure data
security. Additionally, the study examines the impact of software on different sectors such
as education, business, and entertainment. By understanding the role of basic software,
users can optimize their computer usage for better productivity and security. The paper also
discusses challenges related to software compatibility, security risks, and user adaptability.
Ultimately, basic software remains an essential component in modern computing, driving
digital transformation and technological advancement.

2.5.2 Introduction

Software is an essential component of modern computing, enabling users to perform
a wide range of tasks on digital devices. It refers to a set of instructions or programs that
tell a computer how to operate and process data. Software can be broadly categorized into
system software and application software. Software is a collection of instructions, programs,
and data that tell a computer how to perform specific tasks. Unlike hardware, which refers
to the physical components of a computer, software is intangible and operates as the brain
of a system, executing commands to process information and complete various functions.
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Software enables users to perform tasks such as word processing, web browsing,
multimedia editing, gaming, and more. It acts as a bridge between the user and the hardware,
making computers and digital devices functional.

System software includes operating systems (such as Windows, macOS, and Linux)
and utility programs that manage hardware resources and provide a platform for other
software to run. Application software, on the other hand, consists of programs designed
for specific tasks, such as word processing, web browsing, graphic design, and gaming.

Understanding basic software is crucial for both personal and professional use, as it
enables individuals to efficiently utilize digital tools for communication, productivity, and
problem-solving. This introduction provides an overview of different types of software,
their functions, and their role in everyday technology.

In the digital age, software plays a fundamental role in operating and utilizing computers,
mobile devices, and other technological systems. Software is essentially a collection of
instructions that enable hardware to perform specific tasks. Without software, a computer
or digital device would be non-functional.

Software is broadly classified into two main categories:

1. System Software

System software acts as the foundation for a computer’s operation. It includes:

Operating Systems (OS): These manage hardware resources and provide a user
interface. Popular examples include Windows, macOS, Linux, Android, and iOS.

Utility Software: These are specialized programs that enhance system performance,
such as antivirus software, disk cleanup tools, and file management applications.

2. Application Software

Application software consists of programs designed to perform specific tasks for
users. Some common examples include:

Productivity Software: Word processors (Microsoft Word), spreadsheets (Excel),
and presentation tools (PowerPoint).

Multimedia Software: Video players, graphic design applications (Adobe
Photoshop), and music production tools.

a. Web Browsers: Google Chrome, Mozilla Firefox, and Safari, which allow
users to browse the internet.

b. Communication Software: Email clients (Outlook), messaging apps
(WhatsApp), and video conferencing tools (Zoom).
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2.5.3 The Role of Software in Everyday Life

Software has revolutionized industries such as healthcare, education, business, and
entertainment. It enables automation, data analysis, communication, and problem-solving,
making it an indispensable part of modern life.

As technology evolves, software continues to advance, integrating artificial intelligence,
cloud computing, and cybersecurity measures to enhance efficiency and security.
Understanding basic software helps individuals and organizations maximize their use of
digital tools, increasing productivity and innovation.

Software has transformed how we live, work, and communicate. Some key areas
where software plays a critical role include:

Education — Learning management systems (LMS) like Google Classroom and Moodle
help students and teachers engage in virtual learning.

Business & Productivity — Companies rely on enterprise software like SAP and
CRM tools like Salesforce for efficient operations.

Healthcare — Medical software helps in patient management, diagnosis, and treatment
through electronic health records (EHRs).

Entertainment — Streaming services, gaming applications, and digital media platforms
provide endless entertainment options.

Cybersecurity — Security software protects against hacking, identity theft, and data
breaches.

2.5.4 The Future of Software

Software continues to evolve with advancements in artificial intelligence (Al), cloud
computing, and automation. Some of the latest trends in software development include:

Artificial Intelligence (AI) & Machine Learning — Al-powered software enhances
automation, decision-making, and customer service.

Cloud-Based Software — Applications like Google Drive and Dropbox enable remote
access and collaboration from any device.

Cybersecurity Advancements — With increasing cyber threats, security software is
becoming more advanced to protect personal and organizational data.

As technology progresses, software will continue to shape industries and enhance daily
experiences, making it an essential part of modern life.
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2.5.5 Use of Basic Software in Computers

Computers rely on various types of software to function efficiently. From operating
systems to productivity tools, software enables users to perform tasks such as document
creation, internet browsing, communication, and multimedia processing. This article explores
the essential uses of basic software in computers and their importance in daily activities.

2.5.5.1 Operating System — The Foundation of Computing

The Operating System (OS) is the most fundamental software in a computer. It
manages hardware resources, provides a user-friendly interface, and allows users to run
applications. Some key functions of an OS include:

® Managing files and directories (e.g., Windows File Explorer, macOS Finder).
o Running applications and software programs efficiently.

@ Controlling hardware components like printers, USB devices, and memory.

® Providing security features such as user authentication and firewall protection.

Common operating systems include Windows, macOS, Linux, Android, and iOS.

2.5.5.2 Utility Software — System Maintenance & Security

Utility software helps in optimizing and protecting a computer’s performance. Some
key uses include:

® Antivirus Software (e.g., Norton, McAfee, Avast) — Protects against malware
and cyber threats.

® Disk Cleanup & Optimization Tools (e.g., CCleaner) — Removes unnecessary
files and speeds up performance.

® Backup & Recovery Software — Ensures data safety in case of system failure.

These tools enhance the system’s efficiency, security, and overall lifespan.

2.5.5.3 Productivity Software — Work & Office Applications

Computers are widely used for office tasks, documentation, and data management.
Productivity software includes:

® Word Processors (e.g., Microsoft Word, Google Docs) — Used for creating
documents and reports.

® Spreadsheet Software (e.g., Microsoft Excel, Google Sheets) — Helps with data
analysis, financial records, and calculations.

® Presentation Software (e.g., Microsoft PowerPoint, Google Slides) — Used for
creating slideshows and business presentations.

These applications are essential for students, professionals, and businesses.
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2.5.5.4 Web Browsers — Accessing the Internet
A web browser is essential for accessing information online. It enables users to:
® Browse websites and search for information.
® Access cloud-based applications like Google Drive and online banking.
® Download software and updates from the internet.

Popular web browsers include Google Chrome, Mozilla Firefox, Microsoft Edge,
and Safari.

2.5.5.5 Communication Software — Staying Connected

Computers are widely used for communication in personal and professional settings.
Some common communication software includes:

® Email Clients (e.g., Microsoft Outlook, Gmail) — Used for sending and receiving
emails.

® Instant Messaging & Video Conferencing (e.g., Zoom, Microsoft Teams,
WhatsApp) — Enables real-time communication and remote work collaboration.

These applications play a crucial role in businesses, education, and social interactions.

2.5.5.6 Multimedia Software — Audio, Video & Image Processing

Multimedia software is used for creating and editing digital content. Common applications
include:

® Video Players (e.g., VLC Media Player) — Plays various media formats.

o Image Editing Software (e.g., Adobe Photoshop, GIMP) — Used for graphic
design and photo editing.

® Audio Editing Software (e.g., Audacity) — Helps in recording and modifying
sound files.

These tools are widely used in digital marketing, content creation, and entertainment
industries.

2.5.5.7 Entertainment & Gaming Software

Computers are also used for leisure and gaming. Some key entertainment software
includes:

® Streaming Platforms (e.g., Netflix, YouTube, Spotify) — Provides video and music
content.

® Gaming Software (e.g., Steam, Epic Games Store) — Allows users to download
and play computer games.
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Gaming software requires a powerful graphics card and processor for smooth
performance.

2.5.6 Software vs. Hardware

Computers and digital devices rely on both software and hardware to function
effectively. While hardware refers to the physical components of a computer, software
consists of the programs and instructions that run on the hardware. Both are essential and
work together to enable a computer to perform various tasks. This article explores the key
differences, functions, and importance of software and hardware.

2.5.6.1 What is Hardware?

Hardware refers to the physical components of a computer that can be touched and
seen. It includes devices that make up the computer system, such as the processor,
memory, keyboard, and monitor.

2.5.6.2 Types of Hardware:

1. Input Devices — Used to enter data into the computer (e.g., keyboard, mouse,
scanner, microphone).

2. Processing Unit — The brain of the computer that processes data (e.g., CPU,
GPU).

3. Storage Devices — Used for data storage (e.g., hard drive, SSD, USB flash
drive).

4. Output Devices — Displays the results of processing (e.g., monitor, printer,
speakers).

5. Networking Devices — Enable communication between computers (e.g., routers,
modems, network adapters).

Examples of Hardware:
@ Central Processing Unit (CPU) — Processes instructions and performs calculations.

® Random Access Memory (RAM) — Temporarily stores data for quick access.

® Hard Disk Drive (HDD) / Solid-State Drive (SSD) — Stores permanent data and
software.

® Graphics Processing Unit (GPU) — Handles image and video processing.

2.5.6.3 What is Software?

Software refers to a collection of programs and instructions that tell the hardware
what to do. It is intangible and cannot be physically touched.
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2.5.6.4 Types of Software:
1. System Software — Manages hardware and allows other programs to run (e.g.,

operating systems like Windows, macOS, Linux).

2. Application Software — Helps users perform specific tasks (e.g., Microsoft Word,
web browsers, video editing software).

3. Utility Software — Enhances system performance and security (e.g., antivirus, disk
cleanup tools).

Examples of Software:

® Operating System (OS) — Manages the entire system (Windows, macOS, Linux).

® Web Browsers — Allow internet access (Google Chrome, Mozilla Firefox).

® Multimedia Software — For creating and editing videos, images, and audio (Adobe
Photoshop, VLC Media Player).

2.5.6.5 Key Differences Between Software and Hardware

Feature
Definition

Tangibility

Function

Dependence

Examples

Durability

Replacement

Hardware

Physical components of a computer

Can be physically touched
Processes and stores data

Can function without software,

but will not to run perform tasks

CPU, RAM, hard drive,
keyboard, monitor browsers,

Wears out over time (due to usage)

Requires physical replacement if

damaged

Software

Set of instructions that tell a
computer what to do

Cannot be touched, only seen
as programs or files

Operates hardware and
executes tasks

Requires hardware

Operating systems, web
games, office applications

Does not wear out but may
become outdated

Can be updated or reinstalled

2.5.6.6 Relationship Between Software and Hardware

® Software needs hardware to function — A computer program cannot run without
the physical components.
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o Hardware needs software to operate — A computer without an operating system
is just a collection of electronic parts.

® Both works together to allow users to perform tasks like browsing the internet,
writing documents, and gaming.
For example:
® A keyboard (hardware) is used to type in Microsoft Word (software).
® A monitor (hardware) displays content from a web browser (software).

® A processor (hardware) executes instructions given by an operating system
(software).

2.5.7 What is Open-Source Software?

Open-Source Software (OSS) refers to software that is freely available for anyone
to use, modify, and distribute. The source code of such software is publicly accessible,
allowing developers and users to study, improve, and customize it according to their needs.

Unlike proprietary software (which is restricted and controlled by a company), open-
source software promotes collaboration, transparency, and community-driven development.

2.5.7.1 Characteristics of Open-Source Software
1. Free to Use — Open-source software is typically available at no cost.

2. Access to Source Code — Users can view, modify, and improve the software’s
code.

3. Community-Driven Development — Contributions from developers worldwide
help improve the software.

4. Customizable — Users can tailor the software to meet their specific needs.

5. Secure and Transparent — Since many people review the code, vulnerabilities can
be identified and fixed quickly.

2.5.7.2 Examples of Popular Open-Source Software
Operating Systems

® Linux — A powerful OS used for servers, security, and development.

® Ubuntu — A user-friendly Linux-based OS for personal and professional use.
Web Browsers

® Mozilla Firefox — A secure and privacy-focused browser.
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® Brave — A browser designed for fast, ad-free browsing with strong privacy features.

Office & Productivity Software

® LibreOffice — An alternative to Microsoft Office for creating documents,
spreadsheets, and presentations.

® Apache OpenOffice — Another free office suite with word processing and data
management tools.

Development Tools

® Python — A popular programming language for Al, web development, and
automation.

® Git — A version control system used by developers for software collaboration.

Multimedia Software

® GIMP (GNU Image Manipulation Program) — An open-source alternative to
Adobe Photoshop.

® Blender — A powerful tool for 3D modeling, animation, and video editing.

Web & Server Software

® WordPress — A content management system (CMS) used for creating websites
and blogs.

® Apache HTTP Server — A widely used open-source web server.

2.5.7.3 Advantages of Open-Source Software

Cost-Effective — No licensing fees, making it affordable for individuals and
businesses.

Flexibility & Customization — Users can modify the software to suit their needs.

Security — Publicly available code allows for quick identification and fixing of
vulnerabilities.

Community Support — Large developer communities provide support and updates.
No Vendor Lock-In — Users are not dependent on a single company for updates
and maintenance.

2.5.7.4 Disadvantages of Open-Source Software

Less User-Friendly — Some open-source software may require technical
knowledge.

Limited Official Support — Unlike proprietary software, support is often
community-driven rather than provided by a company.
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Compatibility Issues — May not always be compatible with proprietary formats
or software.

2.5.8 Cloud Based Software

Cloud-based software, also known as Software as a Service (SaaS), refers to
applications that run on remote servers and are accessed via the internet rather than being
installed on a local computer. Users can access cloud software from any device with an
internet connection, eliminating the need for physical installation and maintenance.

2.5.8.1 Characteristics of Cloud-Based Software

Internet-Based Access — No need for local installation; users can access
applications from any device.

Remote Storage — Data is stored on cloud servers instead of a user’s hard drive.

Automatic Updates — Software is updated automatically by the provider, reducing
maintenance.

Scalability — Users can adjust their storage and computing power based on needs.
Subscription-Based Model — Most cloud software operates on a monthly or

annual subscription basis.

2.5.8.2 Examples of Cloud-Based Software
1. Productivity & Collaboration Tools

Google Workspace (Docs, Sheets, Slides, Drive) — Online office suite for
document creation and storage.

Microsoft 365 (Word, Excel, PowerPoint, OneDrive) — Cloud-based version
of Microsoft Office.

Dropbox — File storage and sharing platform.
2. Communication & Conferencing Tools
Zoom — Video conferencing and online meetings.
Microsoft Teams — Chat, video meetings, and collaboration software.
Slack — Team messaging and project collaboration tool.
3. Cloud Storage & Backup Services
Google Drive — Cloud storage with integration into Google’s productivity tools.
OneDrive — Microsoft’s cloud storage for syncing and backup.

iCloud — Apple’s cloud service for storing photos, files, and backups.
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4. Business & Customer Management Software

Salesforce — Customer Relationship Management (CRM) platform.
HubSpot — Marketing, sales, and customer service software.

QuickBooks Online — Cloud-based accounting and finance management tool.

. Cloud-Based Development Platforms

AWS (Amazon Web Services) — Cloud computing services for hosting applications
and databases.

Google Cloud Platform (GCP) — Cloud infrastructure for developers and
businesses.

Microsoft Azure — Cloud services for computing, analytics, and Al applications.

2.5.8.3 Advantages of Cloud-Based Software

Accessibility — Access from any device with an internet connection.
Cost-Effective — Reduces expenses on hardware and software installation.
Automatic Updates — Providers manage updates and security patches.

Scalability — Users can upgrade or downgrade their storage and services as
needed.

Collaboration-Friendly — Enables multiple users to work on the same files in real
time.

2.5.8.4 Disadvantages of Cloud-Based Software

Internet Dependency — Requires a stable internet connection to function.
Security Concerns — Data is stored on external servers, posing privacy risks.
Limited Control — Users rely on service providers for maintenance and updates.

Subscription Costs — Recurring fees may be expensive over time.

2.5.9 Whatis Antivirus Software?

Antivirus software is a security program designed to detect, prevent, and remove

malicious software (malware) from computers and other devices. It protects against threats
such as viruses, worms, trojans, spyware, ransomware, and phishing attacks. Antivirus

programs use various techniques like signature-based detection, heuristic analysis, and real-

time scanning to safeguard systems.
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2.5.9.1 Functions of Antivirus Software

Virus Detection & Removal — Scans files and programs for known and unknown
threats.

Real-Time Protection — Monitors system activity to block malicious software
before it causes harm.

Web Protection — Blocks malicious websites and phishing attempts.

Email Security — Scans email attachments for malware.

Firewall Integration — Works with firewalls to provide additional network security.
System Optimization — Some antivirus programs include tools to improve system
performance.

2.5.9.2 Types of Malwares Targeted by Antivirus Software
Viruses — Self-replicating programs that spread by attaching to files.
Worms — Malware that spreads across networks without user intervention.
Trojans — Malicious programs disguised as legitimate software.
Spyware — Collects user data without permission.
Ransomware — Encrypts files and demands payment for decryption.

Adware — Displays unwanted advertisements that may lead to malicious sites.

2.5.10 Summing Up

Software is the backbone of modern computing, making digital devices functional and
useful. System software provides the necessary foundation for a device’s operation, while
application software enhances user experience by enabling specific tasks. Understanding
the basics of software is essential for anyone who interacts with digital technology, as it
improves efficiency, security, and overall digital literacy. As technology evolves, software
will remain a driving force behind innovation and transformation in various fields.

2.5.11 Comprehension Exercises

Long Answer Questions
® What is basic software in a computer?
® What are the main types of software used in computers?
® How does software differ from hardware?

® Why is an operating system essential for a computer?
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Medium Length Answer Type Questions
® What are the functions of an operating system?

® How do different operating systems (Windows, macOS, Linux) compare?
® What is the role of utility software in system maintenance?

® How does antivirus software help in protecting a computer?

Short Answer Type Questions
® Why is it important to update software regularly?
® How do firewalls contribute to system security?
® What is open-source software, and how does it differ from proprietary software?

® How does cloud-based software enhance computing efficiency?

2.5.12 Suggested Readings

Laudon, Kenneth C., and Jane P. Laudon. Management Information Systems: Managing
the Digital Firm. 16th ed., Pearson, 2020.

Shelly, Gary B., and Misty E. Vermaat. Discovering Computers & Microsoft Olffice
2013: A Fundamental Combined Approach. Cengage Learning, 2014.

“What Is Software?” Computer Hope, 18 Jan. 2024, www.computerhope.com/jargon/s/
software.htm.

“Types of Software.” GeeksforGeeks, 22 June 2023, www.geeksforgeeks.org/types-of-
software/.

Singh, Rajiv. “The Role of System and Application Software in Computing.” International
Journal of Computer Science and Technology, vol. 10, no. 2, 2023, pp. 45-52.

Microsoft. “Windows 11 Features and System Requirements.” Microsoft Support, 2023,
www.microsoft.com/en-us/windows.

Oracle. Java Platform, Standard Edition Documentation, Oracle, 2022,
www.docs.oracle.com.
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2.6.1. Objectives

In this unit we will learn about word processingand how to create documents efficiently
and accurately and also to enhance productivity. This unit teaches you how to simplify word
processing tasks, eliminate mistakes, and keep files organized. You will also learn to
collaborate on documents, customize layouts, and automatically catch errors. By mastering
these skills, you’ll save time, cut costs, and produce professional-looking documents with
ease.

2.6.2. Introduction

Word processing refers to the use of computer software to create, edit, format, and
manage digital text documents. It transformed written communication by substituting
typewriters with more versatile and powerful devices. Beyond basic typing, modern word
processors provide a variety of capabilities such as complex formatting, spell checking,
grammatical correction, and the ability to insert photos, tables, and charts. They let users
to effortlessly update and reorganise content, save numerous versions of documents, and
communicate in real time. Word processing software has become an indispensable tool in
businesses, schools, and households, allowing for the quick creation of everything from
basic letters to complex reports and manuscripts. Popular programs such as Microsoft
Word, Google Docs, and Apple Pages have made word processing available to millions
of people, considerably increasing productivity and the quality of written communication
across a wide range of areas and sectors.Some popular word processing software includes,
Microsoft Word, Google Docs, LibreOffice Writer, Apple Pages, OpenOffice Writer etc

2.6.3. Historical Evolution

From the time of mechanical machines to the advanced digital tools of today, word
processing has come a long way. In the 1860s, the first computers were manual typewriters,
which could only write simple text on paper and not make many changes. In the 1960s,
electric typewriters with basic memory features came out. In the 1970s, specialised word
processing systems with small screens and basic digital storage came out. Personal computers
and software-based word processors like WordStar and WordPerfect, which let you edit
and organise text in more complex ways, came out in the 1980s. When it came out in
1983, Microsoft Word quickly became the standard in its field. In the 1990s and 2000s,
WYSIWYG (What You See Is What You Get) writing, graphical user interfaces, and more
advanced features came out. In the mid-2000s, the internet era brought us cloud-based
word processors like Google Docs, which let people work together in real time and view
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the files from any device. Today’s word processors have Al-powered tools for fixing
language mistakes, suggesting styles, and even creating content. This shows how they’ve
changed over time from simple text entry systems to full document creation and management
systems.

2.6.4. Features of Word Processing

2.6.4.1. Text Editing Features
1. Typing and editing text:

Typing and editing text are fundamental features of word processing software,
allowing users to efficiently create and refine documents. This includes inserting text,
formatting fonts, sizes, and colors, and aligning text. Editing capabilities enable
deletion, cutting, copying, pasting, undoing, and redoing actions.

2. Cut, Copy, Paste:

Cut, Copy, and Paste are important editing tools in word writing software that
make it easy to change text. If you press Ctrl+X, the chosen text is erased and
saved in the clipboard. If you press Ctrl+C, the text is copied without being erased.
When you press Ctrl+V, the copied or cut text is pasted into the desired position.
This makes it easy to move or copy content within a document or between documents
and applications, which speeds up the editing and formatting process.

3. Undo and Redo:

The undo (Ctrl+Z) and redo (Ctrl+Y) keys in word writing software are very
important for editing because they make it easy to go back and fix mistakes. Undo
undoes the most recent action and returns the text to the way it was before. Redo
does the action that was undone again. This dynamic pair lets users try out different
formatting, editing, and content changes without worrying about making mistakes
that will stick around. This gives users freedom and control over how the document
changes over time. By pressing Undo and Redo over and over, users can go
through a series of changes and make exact changes to get the results they want.

4. Find and Replace:

With word writing software’s Find and Replace feature (Ctrl+F), users can quickly
find and change certain text in a document. Find helps you look for a word or
phrase and highlights all occurrences of it. Replace, on the other hand, helps you
swap the found text with new text, either one occurrence at a time or all at once.
This feature makes editing easier, which saves time and cuts down on mistakes. It
often comes with advanced features like case sensitivity, whole word matching, and
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style searches, which make it an essential tool for improving and polishing documents.

. Spell-checking and Grammar-checking:

Spell- and grammar-checking are built into word processing software and check
papers automatically for mistakes to make sure they are correct and professional.
Spell-checking finds and fixes misspelt words, and grammar-checking finds and
offers fixes for spelling, grammar, punctuation, and syntax mistakes. A lot of the
time, these features use dictionaries, thesauri, and linguistic algorithms to give users
real-time feedback, flags, and ideas that help them quickly find and fix mistakes.
Some software also has more advanced features, such as contextual spelling, grammar
explanations, and style checking, that help users improve their writing and make
papers that are polished and free of mistakes.

2.6.4.2. Document Formatting Features

1. Font styles, sizes, and colours:

Font styles, sizes, and colours are important formatting tools in word writing software
that let users make documents easier to read and look better. You can choose from
bold, italic, underline, and strike-through font styles, and font sizes run from small
to extra-large. Font colours also give users a huge range of options; they can use
different shades to draw attention to important text, make headings stand out, or
match brand names. Users can also pick from different font families (like Arial,
Calibri, and Times New Roman) and add effects like shadow, outline, and emboss
to make papers that look great, grab readers’ attention, and get their point across
clearly.

. Alignment (left, center, right, justify):

Word processing software has alignment options that let users carefully control
where text appears in a document, making it easier to read and looking better. Left
Alignment starts the text at the left margin, Right Alignment ends it at the right
margin, Centre Alignment makes the text evenly spaced around the middle, and
Justify makes the text stretch to fill the whole line, making a regular margin. These
options let users make documents that look balanced and professional, like reports,
newsletters, and resumes. They can do this by changing the alignment of text in
headings, paragraphs, and tables to meet specific design needs and create a smooth
and consistent style.

. Margin and indentation control:

Word editing software has controls for margins and indents that let users finetune
text spacing and layout. You can change the top, bottom, left, and right edges in
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the margin settings to define the text area. You can set the distance between the text
and the margins with Left/Right Indent, First Line Indent, and Hanging Indent. First
Line Indent indents only the first line of a block. Hanging Indent indents all lines
except the first. Users can also set Tab Stops to align text at certain places and
improve the flow of text with tools like Line Spacing and Paragraph Spacing
(before and after). These features give you exact control over how documents are
laid out, which makes them easier to read and look better.

4. Line spacing and paragraph formatting:

Word processing software has tools like line spacing and paragraph formatting that
let users change how text is laid out and how easy it is to read. With line spacing
options, you can choose between single, double, or custom spacing for the space
between lines. With paragraph layout options, you can change how paragraphs are
indented, aligned, and spaced before and after them.

5. Headers, Footers, and Page Numbers:

Headers show text or pictures that are repeated at the top of every page, and
Footers show up at the bottom. Users can add things like document titles, author
names, times, and page numbers. You can have page numbers added immediately,
and you can choose how they look, where they go, and where the first page
number goes.

2.6.4.3. Organization and Navigation Features
1. Indexing and Tagging:

Indexing allows users mark important words, phrases, or ideas, and it creates an
index instantly. Tagging, which is also called bookmarking or key wording, lets
users give categories, labels, or metadata to certain text, images, or sections.

2. Bookmarks and Hyperlinks:

Hyperlinks allow users make clickable connections between text, images, or parts
within a document or to external resources like websites, email addresses, or files.
Bookmarks allow users mark specific places in a document for quick access.
Bookmarks and hyperlinks make documents easier to use, make navigation easier,
and offer a flexible way to connect and share information. This makes them necessary
for making interactive reports, slideshows, and documents.

3. Table of Contents:

A Table of Contents is a navigational tool in word processing software that creates
an organised list of headings, subheadings, and page numbers so that you can
quickly get to certain parts of a document.
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4. Search and Replace:

Word processing software has a tool called “Search and Replace” that lets users
quickly find and change certain text in a document. Users can look for a word,
phrase, or format and replace it with new text, formatting, or styles. They can do
this for one instance at a time or for all instances at once. The Search and Replace
tool makes editing easier, takes less time, and cuts down on mistakes. It is a must-
have for improving and polishing documents.

5. Document Outline:

To create a document outline in Microsoft Word, Google Docs, LibreOffice Writer,
or Apple Pages, go to “View” > “Outline” (or press Ctrl+Alt+O in Word, Ctrl+Alt+O
in Google Docs, Ctrl+Shift+O in LibreOffice, or Command+Shift+O in Pages).
This displays the Outline pane, where you can use headings (Heading 1, Heading
2, etc.) to create outline levels. Promote/Demote headings to change levels, move
headings to reorder content, collapse/expand headings to hide/show subpoints, and
use drag-and-drop or cut/copy/paste to reorganize. This feature helps visualize and
structure your document, making it easier to navigate and edit.

2.6.5. Starting the Word Processor

In the majority of cases, we will be able to initiate the word processor of our choosing
from the Program option in the Windows Start menu. We could also establish a desktop
shortcut to access our word processor or we can find it simply from the search option.

To open Microsoft Word 2010 from the Start Menu:
1. Click the Start button, navigate to All Programs, select Microsoft Office, and then
click on Microsoft Word 2007.

2. This starts the Microsoft Word 2007 application, displaying a new blank document
on the initial screen.
Let’s look at the different parts of this window that are important:

1.File Tab: In Word 2007, the Office button was changed to the File tab. It lets you
see the backstage view, which is where you open or save files, make new documents, print
documents, and do other things that have to do with files.

2. Quick Access Toolbar: This is the Quick Access Toolbar, which is located just
above the File tab. Its job is to make it easy to find the Word functions you use most often.
This menu can be changed to suit your needs.

3. Ribbon: The directions on the ribbon are organised into three groups:

(i) Tabs: These run across the top of the Ribbon and hold groups of commands that

are linked. Ribbon tabs are things like Home, Insert, and Page Layout.
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(ii) Groups: Groups organise commands that are linked. The name of each group
shows up below the group on the Ribbon. For instance, a Font group is a set of
commands about fonts, a Paragraph group is a set of commands about layout, and
SO on.

(ili) Commands: Commands show up in each group. Bold, Italic, and Underline are
some of the instructions that show up in the Font group of the Home tab.

File Tab Ribbon Title bar
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4. Title Bar:The title bar is at the very top of the window. It shows the names of the
programs and files.

5. Rulers: Word has two rulers, one that goes across the page and one that goes up
and down. The horizontal line shows up right below the Ribbon and is used to set blank
spaces and tab stops. The vertical line is on the left side of the Word window and is used
to check where things on the page are in relation to each other.

6. Help: You can use the “Help” icon at any time to get help with words. This is a
lesson on a variety of Word-related topics.

7. Zoom Control: For a better look at your words, you can zoom in with the zoom
control. If you want to zoom in or out, you can move the tool to the left or right. You can
click the + and - buttons to make the zoom factor bigger or smaller.
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8. View Buttons: The five buttons to the left of the Zoom control, close to the bottom
of the screen, let you change between Word’s different document views.

(i) The Print Layout view: This displays documents in the exact same manner as
they will appear when printed.

(ii) Full Screen Reading view: This provides a full-screen view of the document.

(iii) Web Layout view: This displays the appearance of a document when viewed
through a web browser, such as Internet Explorer.

(iv) Outline view: The outline view division of a document into sections is determined
by the text and headings. A primary concept is symbolised by a heading. A specific
heading is accompanied by one or more paragraphs in the text.

(v) Draft view: This mode displays the document without top or bottom page margins,
and page breaks are represented by dotted lines. For instance, headings and footers
are not displayed.

9. Document Area: The document area is the location in which you type. The
insertion point is the flashing vertical bar that denotes the location at which text will be
displayed as you compose.

10. Status Bar: This section displays the insertion point location and document
information. The total number of pages and words in the document, as well as the language,
are displayed in this bar from left to right.

11. Dialogue Box Launcher: This is represented by a diminutive arrow in the lower-
right corner of numerous groupings on the Ribbon. A dialogue box or task pane that offers
additional options regarding the group is initiated by clicking this icon.

2.6.6. Creating a New Document

Files created using Microsoft Word are referred to as Documents. To create a new
document in Microsoft Word, open the program and click “File” > “New” or press Ctrl+N
(Windows) or Command+N (Mac). Alternatively, click the “File” tab and select “New
from template” to choose from various templates. You can also customize document settings
by clicking “Options” in the left pane. Choose a template or select “Blank Document”, then
click “Create” to open a new document. The new document will automatically open with
default settings, ready for editing.
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2.6.7. Opening an Existing Document:

Using the File Menu

Open Microsoft Word.

J

Click on “File” in the top-left corner.

J

Select “Open” from the drop-down menu.

In the “Open” dialog box, navigate to the location where your document is saved.

J
J

Select the document file (e.g., .docx, .doc).

J

Click “Open” to open the document.

Using Recent Documents

First Open Microsoft Word.

J
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Click on “File” in the top-left corner.

J

Select “Open” > “Recent Documents”.

J

Opened documents list will appear

J

Click on the required document

2.6.8. Summing Up

Word processing has evolved from simple text editing to sophisticated document
creation and management. Understanding its features and best practices can significantly
improve productivity and document quality. As technology advances, word processors
continue to become more powerful and user-friendly, remaining essential tools in both
professional and personal contexts.

2.6.9. Comprehension Exercises

1. Create a word document using word processing and rename the file.
2. Write this passage in MS Word and save the file.

Word processing has evolved from simple text editing to sophisticated document
creation and management.

Understanding its features and best practices can significantly improve productivity
and document quality.

3. Use cut and paste options and move the 2" line of the passage to the middle of
the page.

4. Open the same file following the instructions.

5. Open a new file following the instructions.

2.6.10. Suggested Readings

Cox, Joyce and Joan Preppernau. Microsoft Office Word 2007 Step by Step. Microsoft
Press, 2007

Gookin, Dan. Word 2016 for Professionals. For Dummies, 2016.
Lambert, Joan. Microsoft Word 2016: Step by Step. PHI Learning Pvt Ltd, 2006.
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2.7.1. Objectives

After completing this unit, you should be able to:
Understand the fundamental features of Excel

Create worksheets and perform data computations

Recognise and navigate the Excel screen layout

Develop and manage worksheets effectively in Excel

[ ]
[ ]
o
® Identify and describe the various icons in the Excel menu
[ ]
® Organise data using charts and graphs

[ ]

Apply print settings and print worksheets efficiently

2.7.2 Introduction

A spreadsheet is a digital tool that helps organise, calculate, and analyse data. It
consists of a grid made up of rows and columns, where each intersection forms a cell to
store information such as numbers, text, or formulas. Spreadsheets are widely used for
tasks like budgeting, accounting, and data management because they allow users to perform
complex calculations quickly and visualise information through charts and graphs.

Microsoft Excel, Google Sheets, and LibreOffice Calc are some of the most popular
spreadsheet programs. These tools provide features like automatic calculations, data sorting,
and the ability to create graphs to represent data visually. Spreadsheets are not limited to
business or finance; they are also useful for academic research, project planning, and
personal tasks like tracking expenses or managing schedules.

For students, especially those studying humanities, spreadsheets can simplify the
organisation of large data sets, bibliographies, and research findings. Learning to use
spreadsheets enhances data literacy, making it easier to interpret and present information
effectively. Understanding how to create and manage spreadsheets is a valuable skill in
today’s data-driven world and is applicable to professional and personal tasks.

2.7.3 Learning MS Excel

Microsoft Excel is a widely used spreadsheet program designed to help users manage
everyday tasks such as creating budgets, maintaining address lists, and organising to-do
items. As part of the Microsoft Office suite, it is often pre-installed on computers, making
it easily accessible. To start using MS Excel, you can open it through one of the following
methods:
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2.7.3.1 Using the Start Menu
a. Click on the Start button or press the Windows key on your keyboard.
b. Type ”Excel” in the search bar.

c. Click on Microsoft Excel from the search results to open the program.

2.7.3.2 Using a Desktop Shortcut
If there is an Excel icon on your desktop, double-click it to launch the application.

These simple steps allow you to access Excel quickly, ready to explore its versatile
features for organising and analysing data efficiently. When you open Excel, a new file
called a Workbook is automatically created with the default name Bookl. Each new
Workbook you open is numbered sequentially (Book2, Book3, etc.). You can open multiple
Workbooks at the same time. By default, each Workbook contains three worksheets, but
you can add or remove worksheets as needed, which you will learn later.

Additionally, you can open Excel by clicking on any saved Workbook file on your
computer. Excel will launch automatically, and the selected Workbook will be displayed in
the Excel window.

2.7.3.3 Excel Screen Layout
Let us know about the key components.

2.7.3.3.1 The Microsoft Office Button

The Microsoft Office Button is found in the top-left corner of the Excel window. When
you click on it, a menu appears that lets you create a new Workbook, open an existing
one, save your work, print, and do other important tasks.

The Quick Access Toolbar is right next to the Microsoft Office Button at the top. It
gives you quick access to the commands you use most often. By default, it includes options
like Save, Undo, and Redo. Let us know about the shortcuts:

a. Save: Saves your file (shortcut: Ctrl + S).
b. Undo: Reverses the last action you performed (shortcut: Ctrl + Z).
c. Redo: Restores an undone action or repeats the last action (shortcut: Ctrl +Y).

2.7.3.3.2 The Title Bar

The Title Bar is located next to the Quick Access Toolbar at the top of the Excel
window. It displays the name of the Workbook you are working on. Automatically, the first
new Workbook will be called “Book1,” and any additional Workbook is given the next
number. You can save your Workbooks with any valid name you choose.

2.7.3.3.3 Configuring Your Excel Environment

Before you start working on a spreadsheet, it’s good to set up your Excel workspace
and learn a few basic tasks. These include making the Ribbon bigger or smaller, customising
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the Quick Access Toolbar, showing or hiding the formula bar, and changing how the page
looks, among other options.

Minimise and Maximise the Ribbon

® Right-click anywhere on the main menu.

® Click on Minimise the Ribbon to turn it on or off.

® A check mark next to Minimise the Ribbon means it is active.
o

Use this option if you prefer using menus and keyboard shortcuts instead of the
Ribbon.

® You can also choose to move the Quick Access Toolbar below the Ribbon from
this menu.

® You can also Customize the Quick Access Toolbar using the option available in this
menu.

Customise the Status Bar

® You can click Right anywhere on the Status Bar.

® You can customise your menu from the status bar.

Zoom In and Out

® You must locate thezoom bar in the bottom, right corner.

® By clicking left in the slider, you can zoom in and out easily

® Also, you can use the View tab on the top to change your zoom setting anytime

Change Page Views
You may easily find the the Page View options in the bottom, right corner. After
finding it, click on any option to select it. Now let us know about various page view
options:
® Normal View: This is the default view when you open Excel.
® Page Layout View: This view helps you prepare for printing.
< You can see the header section, margins, rulers, and column/row headings.

< It shows exactly how your Workbook will look when printed.

2.7.3.3.4 Customising the Environment Using Excel Options

The Excel Options menu allows you to personalise Excel to suit your preferences. To
open it, click the Microsoft Office Button and select ‘Excel Options’ at the bottom of the
menu. Here, you can change settings like the mini toolbar, live preview, colour themes,
sorting and filling options, auto-correction, default workbook settings, and options for
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calculations, editing, copying, and pasting. These customisations help make using Excel
easier and more convenient for your work.

2.7.4. Excel Menu

Menu Bar

® Located at the top of the Excel window.

@ Contains various tabs: File, Home, Insert, Page Layout, Formulas, Data,
Review, and View.

® Each tab consists of related commands grouped together.
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Figure 1. Menu Bar
Formula Bar
® Positioned below the Menu Bar.
® Displays the contents of the selected cell.
@ Used to enter, edit, and view formulas and data.
Spreadsheet Area (Worksheet)
® The main working space is where data is entered and organized.
® Consists of rows (numbered) and columns (lettered) forming cells (e.g., A1, B2).
® Supports text, numbers, formulas, and formatting.
Status Bar
® Located at the bottom of the Excel window.
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® Shows real-time information like the sum, average, and count of selected cells.

® Includes worksheet view options and zoom controls.

2.7.3.4 Format of Worksheets

2.7.4.1 Data handling and editing

You need to open the Workbook to start working on any worksheets. You will also
learn how to insert and delete a worksheet easily through the following steps:

® Insert a Worksheet: First, go to the Insert menu. To begin with, you will see a
dialog box. From there,you can easily insert a worksheet by confirming the command.

® Delete a Worksheet: If you wish toremove a worksheet, select Delete Sheet in
the Edit menu. Again, you will find a dialog box asking for confirmation.

® Move the Worksheet: To move a worksheet within the same Workbook, click
and hold the sheet tab, then drag it to your desired position. Release the mouse
button to place it.

2.7.4.2 Formatting

Now, it’s time to learn about formatting techniques. For you, there are many options
available in MS Excel for formatting. For this, you have to click the Home tab. The options
are as follows:

1. Clipboard: Here, you may easily find the options available for your datasheet, such
ascut, copy, and paste. Also,format painter makes your task easier while entering a dataset.

® Cut: Removes the selected content and places it on the clipboard.
® Copy: Copies the selected content to the clipboard without removing it.
@ Paste: Insert the content from the clipboard into your document.

® Format Painter: Copies formatting from one section and applies it to another.
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Figure 2. Cut, Copy, Paste, Insert, Delete options

1. Types of Alignment:In a spreadsheet, alignment refers to how the content within
a cell is positioned horizontally and vertically. You can control alignment to improve
readability and presentation. Here’s how it works:

a. Horizontal Alignment:
® Left Align: Aligns text to the left of the cell (default for text).
@ Center Align: Centres content within the cell.
@ Right Align: Aligns content to the right (default for numbers).
Shortcut keys:
® Left: Ctrl+L
® Center: Ctrl+ E
® Right: Ctrl+ R
b. Vertical Alignment:
Aligns content at the Top, Middle, or Bottom of the cell.
Found in the “Alignment” group on the toolbar or ribbon.
¢. Wrap Text:
® Makes text fit within the cell by displaying it on multiple lines.
@ Shortcut: Alt+ H, W.
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d. Merge and Center:
® Combines selected cells and centers the text.
® Shortcut: **Alt+H

2. Sort & Filter: Sort and Filter are essential tools in a spreadsheet to organise and
analyse data efficiently. Here’s how they work:

Sort :Sorting arranges data in a specific order to make it easier to understand.

® Ascending Order: Sorts text alphabetically (A to Z), numbers from smallest
to largest, or dates from oldest to newest.

® Descending Order: Sorts text alphabetically (Z to A), numbers from largest
to smallest, or dates from newest to oldest.

Process:
® Select the column or range of cells you want to sort.
® Go to the “Data” tab and click “Sort.”
® Choose the column and specify ascending or descending order.
@ Shortcut: Alt+D + S

Filter: Filtering displays only the data that meets specific criteria while hiding other
TOWS.

How to Apply a Filter:
® Sclect the data range, including headers.
® Go to the “Data” tab and click “Filter.”

® Dropdown arrows appear in the header cells. Click an arrow to choose filter
conditions (e.g., show only data for a specific category).

® Shortcut: Ctrl + Shift + L

3. Find & Select: a spreadsheet helps you quickly locate and work with specific
data. Here’s how it works:

Find: The Find feature lets you search for specific text or numbers in your worksheet.
Process:

® Press Ctrl + F to open the Find dialog box.

® Type the text or number you want to find.

® Click Find Next to move through each occurrence or Find All to list all matches.
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Replace: The Replace option allows you to find specific data and replace it with
new content.

Process:
® Press Ctrl + H to open the Replace dialog box.
® Enter the text to find and the text to replace it with.
® Click Replace or Replace All to update the content.
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Figure 3. Find and Replace
Select: The Select options help you choose cells based on specific criteria.
® Go To Special:
< Press F5 or Ctrl + G, then click Special.

< Choose options like blanks, formulas, or conditional formatting to highlight
relevant cells.

These features improve efficiency by saving time and ensuring accuracy in large data
sets.

2.7.4.1 Naming Cells and Ranges

Assigning a descriptive name to a cell or range in Excel makes your formulas easier
to read and manage. Instead of relying on confusing cell references like A1 or B2, range
names help you clearly understand the purpose of a formula. For example, naming a range



86 NSOU ¢ NSE-EG-03

“Sales Total” makes your formula more meaningful than standard cell coordinates. This
improves clarity and simplifies future edits.

Here’s how to name cells in a spreadsheet in simple steps:

a. Select the cell you want to name by clicking on it.

b. Go to the Name Box in the top left corner (next to the formula bar).

¢. Click inside the Name Box and type the name you want to give to the cell.
< Example: Type “Total” if you are naming a cell for the total amount.

d. Press Enter to save the name.

You can use this name in formulas or functions instead of the cell reference (like A1).

2.7.5 Organizing Charts and Graphs

This option allows you to create different types of ready-made charts and graphs. It
uses the data you entered, adds a datasheet, and generates a chart. After clicking the Insert
tab, you will see various chart options. You can choose the type of chart you want, such
as Column, Pie, Line, Bar, Area, or Scatter. More chart styles can be found under the
“Other Charts” option.

a. Column: Used to compare values across different categories.

=

Line: Displays trends over a period of time.

Pie: Shows how each value contributes to the total.

o

Bar: Compares multiple values side by side.

Area: Highlights differences between multiple sets of data over time.

- @

Other: Offers additional chart types for more specialised visualisations. They are:
1. Stock

Surface

Doughnut

Radar

Bubble

AT
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Figure 4. Chart: Column

2.7.6 Basics of Multiple Spreadsheets

In this section, we will learn how to name, add, delete, and save worksheets. We will
also learn to format a worksheet for printing.

2.7.6.1 Naming a spreadsheet

As you know, naming a worksheet can be an interesting task. Generally, the default
names of Worksheets are Sheetl, Sheet3 and Sheet3. Since these names are not useful
and descriptive, we will learn to rename the worksheet.

You can rename a worksheet using any of the following ways:
® Right mouse click on the Sheet! tab.

® Seclect the option Rename. A black box highlights the name Sheet1 and becomes
editable.

® Type the new name in the tab.

® Press Enter. The worksheet is renamed.



88 NSOU e NSE-EG-03

Figure 5. Naming a Worksheet

2.7.6.2 Inserting a new spreadsheet

Now let us learn how to add a new spreadsheet. You can add new worksheets to your
Workbook anytime. The added sheets will be named sequentially, such as Sheet4, Sheet5,
and so on. Here are different ways to add a new worksheet:

® Click the Insert Worksheet icon next to the worksheet tabs or press Shift + F11.
® A new worksheet will be added after the last tab.

® Right-click on any worksheet tab.

® Choose Insert from the menu, and an Insert dialog box will appear.

® Sclect Worksheet and click OK.

® A new worksheet will be added before the currently selected tab.

2.7.6.3 Deleting a spreadsheet

Let’s learn how to delete a spreadsheet. You can delete any number of worksheets,
whether they contain data or not. However, a Workbook must have at least one worksheet.
To delete a worksheet:

First, Right mouse click on the worksheet tab. Then, choose Delete from the menu.
Just like that, the selected worksheet has been deleted.

2.7.6.4 Repositioning of a spreadsheet in a workbook
Let’s learn how to reposition the position of worksheets in a Workbook:

e First, you have to click and hold the worksheet tab,which is to be moved, until an
arrow appears on the left corner of the sheet.
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® Next, you have to drag the worksheet to the desired location

2.7.6.5 Saving a spreadsheet

As you know, saving a spreadsheet is one of the easiest tasks. Let’s learn about its
purposes:

o First, you must open a Workbook

® Then, after opening it, you can edit a Workbook

This can be easily done while saving a workbook. Simply opt for “General options”
through the Tools button, which you will find near the Save Button.

2.7.6.6 Printing a Spreadsheet

Now your Workbook is ready for printing. Let’s learn the basics of printing. Once you
finish your work in a Workbook, you would like to have some prints of your worksheet.
For this, you have to follow the given instructions:

® Click Office button
® Seclect Print option
® Choose the option out of the given list

In the Print section, there will be two options. First, you have to click Quick Print,
where you can select the number of pages, and then you have to see the Print Preview.
After that, your spreadsheet will come out in a printed format.
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Figure 6. Printing a Worksheet
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2.7.7 Summing Up

This module introduces the basic features of Microsoft Excel, a powerful tool for
organising and analysing data. It covers navigating the Excel interface, including understanding
the workbook, worksheets, and essential components like the Ribbon, Quick Access
Toolbar, and Title Bar. You will learn how to create and save workbooks, customise your
Excel environment, and use Excel Options to personalise settings. The module also explains
how to input data, use formulas for calculations, and format cells to improve readability.
Additionally, you will explore how to create and customise charts and graphs to represent
data visually. Practical tips on organising data, managing multiple spreadsheets, and printing
worksheets are also included. By completing this module, you will develop a strong foundation
in using Excel for various academic and personal tasks involving data management and
analysis.

2.7.8 Comprehension Exercises

1. Identify the following elements on the Excel screen:
a. Ribbon
b. Quick Access Toolbar
c. Title Bar
d. Formula Bar
Describe how to add or remove icons from the Quick Access Toolbar.
Create a new workbook and rename it as MyFirstWorkbook.
Save the workbook in a folder named Excel Exercises on your computer.
Change the colour scheme of Excel using the Excel Options menu.
Hide the formula bar and restore it.
Adjust the page layout to landscape mode and print preview the worksheet.

Insert a new row above the first row in a worksheet.

o N kW

Delete the third column in the worksheet.

[S—
=]

. Rename the worksheets as Students, Subjects, and Marks.

2.7.9 Suggested Readings

Balagurusamy, E. Fundamentals of Computers. McGraw Hill Education, 2014.
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Goel, Anita, and Ajay Mittal. Computer Fundamentals and Office Automation. Pearson,
2012.

Kumar, Satish Jain, and Shashank Jain. MS Office 2010 Training Guide. BPB Publications,
2012.

Lal, Hirdesh. MS Excel Made Easy. BPB Publications, 2021.
Mehta, Neetu. Learn Microsoft Excel Step-by-Step. Global Vision Press, 2020.
Sinha, P.K., and Priti Sinha. Computer Fundamentals. BPB Publications, 2004.
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Unit 8 7 Presentations and Data Visualization Basics

Structure

2.8.1. Objective

2.8.2. Introduction

2.8.3. Importance of Effective Visual Communication
2.84. Introduction to Power-Point

2.8.5. Overview of Power-Point Interface

2.8.6. Understanding Slide Layouts and Designs
2.8.7. Steps to Create PPT

2.8.8. Use of Audio-Visual Method in PPT

2.8.9. Mastering Slide Layouts

2.8.10. Benefits of Learning PPT

2.8.11. Summing Up

2.8.12 Comprehension Exercises

2.8.13 Suggested Readings

2.8.1. Module Objective

This module aims at learning and understanding the process of creating PPT and its
benefits. It aims at providing a graphical example with exact screenshots and vivid description
of the key elements required behind the creation of PPT. This module will introduce the
readers to PowerPoint and steps to create a PowerPoint presentation, understanding slide
layouts, ways to enhance visual appeal of PPT, things to keep in mind while preparing a
PowerPoint presentation, ways to achieve mastery in making PPT presentation. This module
will not just only introduce the readers in understanding PPT and preparing a PPT all by
himself/herself, but also give an insight into the benefits of learning PPT. This module will
conclude with the understanding of the necessity behind learning a PPT and its upcoming
benefits for the students. Therefore, the overall model will take the readers to a journey
from introducing them to PowerPoint, methods and processes in preparing a PPT and its
consequent effects and benefits.
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2.8.2 Introduction

PPT or Power Point Presentation has become a necessary aspect for any branch of
education, profession and field, be it Arts, Commerce and Science or be it business, IT
Sectors, Science Projects or anything. For each and every existing field there is the
necessity of Power Point Presentation for its visual representations and its consequent
benefits in the teaching-learning process or in several other fields where PPT aids to the
presentation of particular argument, information, skill, data, graphical representations and
many more. The mode and method of PPT varies according to the need of the circumstances.
The dynamic range and growing requirement for a quick presentation via a power point
presentation has made it an absolute necessity to learn and understand the methods, ways
of creating PPT, various designs and content presentation. Therefore, this module chiefly
aims to highlight the importance of PPT, the methods and processes to create a well-
designed PPT, the benefits of PPT and so on.

2.8.3 Importance of Effective Visual Communication

Now-a-days the use and requirement of PowerPoint presentation has become a
necessity be it in the corporate sector, education or in the field of science and marketing.
This method is very much beneficial for transmitting any idea in the shape of structured
graphical representation. This not only quickens the process of transmitting data, idea,
information or any kinds of knowledge. However, one must be aware about the usage of
PPT, the methods, procedure and graphical presentation differs according to the field and
need. Although PPT is an amalgamation of everything, one can use text, table, numbers,
charts of various kinds, images (black/white or colored), various shapes, fonts, word arts,
background color, highlights and many more. The dynamic range of PPT therefore can
cater to every need and idea. One can very easily narrow down any idea into a five to ten-
minute PPT, which otherwise would have taken hours to elaborate and explain even by
using economy of words. Therefore, the effectiveness of the PPT in summarizing and
providing the totality of any idea in a glimpse becomes very much crucial. For an example
if we want to understand the growth in the population, economic growth, production
growth in any of the company, presenting any idea we would require the usage of PPT
which at once let the audience or the receiver, to grapple the gist of the matter in a rather
quick manner. However, we must learn to use the PPT in a very efficient manner otherwise
it becomes very easy to mislead people, the audience or the receivers. Therefore, the
arbitrariness of the PPT must be kept in mind, for it is not only beneficial but can be
misleading too, if not used efficiently. Nevertheless, PPT is very effective in giving the
audience or the receivers a great Audio-visual method for their better understanding of any
concept, idea of any kind of information.
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2.8.4 Introduction to Power-Point

What is a PowerPoint? PowerPoint is basically a slide show presentation program, it
is one of the most used software programs within Microsoft Office, which also contains
program like MS-WORD, MS-EXCEL etc. This program is chiefly build and designed for
the purpose of conveying information and data by using multimedia in a rather quick
manner. There are various kinds of keys, settings, options and tools bundled within the
MS-PowerPoint program. By using such tools and options any sort of designs and
presentation can be presented. Some years ago, there has been the standard usage of static
PPT’s but now-a-days PPT’s can be made in various ways, by using animation, adding
videos and so on. The limitations of PPT has reduced significantly this day. With the
invention of Artificial Intelligence (Al), now PPT’s can be made and designed through a few
commands and keys. There has been various other websites and apps that are available
through which one can make their PPT, such as CANVA, PREZI, POWTOON, GOOGLE
SLIDES, HAIKU DECK, BEAUTY.AI, EMAZE, SWAY, GENIALLY, SWAY and so
on. However, PowerPoint still remains one of the most authenticated programs for making
PowerPoint presentation. One can easily start making PowerPoint presentation by opening
the program from Microsoft Office, after that they will have to add a blank slide or choose
any of the pre-installed templates to make their presentation. One can easily add, draw,
insert text/image, videos various designs, tables, charts of various kinds according to the
need and so on. However, it needs to be remembered that the beauty of the PowerPoint
presentation does not lies in the technique or process of making the PPT but in its
effectiveness. The more fluent and efficient the presentation is in transmitting the idea,
information or knowledge, the more effective it becomes. Therefore, one must be aware
about the field, purpose and the idea within the presentation before choosing a suitable
template or creating one.
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2.8.5. Overview of PowerPoint Interface

The PowerPoint interface has many keys, tools, options, layouts, designs, word arts
and so on. However, one needs to understand the usage of Program Frame, Menu Tabs,
Ribbon, Groups, Slide Preview, Workspace, View Options & Slider. In the homepage of
the PowerPoint program, there are various tools that one must understand the usage of
before applying it into the PowerPoint presentation. One must start by adding a blank slide
and then one can reshape, insert design, resize the slide, adding colors, shapes and designs.
However, one must keep in mind that adding abundant designs, shapes and too many
colors, word arts and different fonts may produce a negative visual effect which can have
an adverse effect and it can destroy the aesthetic beauty and visual equilibrium with the
lecture or dialogue.
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Blank Slide of PPT

2.8.6 Understanding Slide Layouts and Designs

Slides are the major and key elements of PowerPoint presentation therefore one must
be cautious about choosing the number of slides and designs on it. If someone wants to
use the same template for all the slides within the presentation then there is an option to
duplicate the slide and by that one can easily use the same kind of slide design with different
content in it for the preparation of the presentation. Slides are majorly used for containing
several contents in a nutshell and providing each content the space and method it needs.
For an example, if one is required to provide characteristics of something, then one may
use bullet points or other kinds of serializing designs such as number, alphabet, pattern,
Romans and various other designs as well. If one needs to add a photo or show any kinds
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of video content then one will need added slides. Therefore, the number of slides and
pattern or designs of the slides are based upon the content which one intends to present.
There are also several other options and features that one may use such as watermark,
background color, use template PPT’s for a fixed purpose and several numerous tools and
features to add and make the presentation eye catching as well as efficient in content. One
must understand that only the designs and coloration of the PowerPoint presentation does
not necessarily make it a good PPT, the content within the slides is mostly important.
Therefore, one must focus on the content of the PPT, rather than the design. However, the
way one presents a particular content in a very attractive and efficient manner makes the
presentation or the PPT much more attractive.

2.8.7 Steps to Create a PPT

To create a PPT one must use a Desktop, Laptop and use the pre-installed Microsoft
PowerPoint program from the MS-Office suit of a computer. However, if in any certain
incident, the PowerPoint program is not available, one must install the program and by
opening it one must either choose and blank slide or a particular template from the default
template set up. However, it is better suggested to create a PPT by your own self because
it does not only show your efficiency but also shows the summarizing skills, observation
skills, pointing out the key aspects and highlighting them. Therefore, the PPT associates
itself with various kinds of skills and by therefore it also needs an imaginative mindset of
the presenter to create an efficient and effective PPT for presentation. Following are the
basic steps to create a PPT-

Opening PowerPoint program

l

Choose Blank Slide/Template

l

Add Text within the Text Box

l

Add/Insert Image/table/shapes/color/background etc...

l

Start by introducing the Presentation Topic

l
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The Content of the Presentation

g

Adding Content Text/Image/Video

g

Concluding part, the PPT

g

Showing Gratitude/End Slide (Thank You)
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Example of PPT slides

Image source: slidehunter

2.8.8 Use of Audio-Visual Method in PPT

PPT is dynamic in nature and there are no particular boundaries for creating a PPT.
However, the inclusion of Audio-Visual aid within the PPT enhances the effectiveness of
the presentation. Therefore, the inclusion of Audio-Visual aid always enhances the validity,
the visual experience and understanding of the audience or the receiver. However, the
duration of the Video, if any, is required, has to be kept in mind, it should be as precise,
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exactly like the economy of words that you use in your PPT making. The Video should
not be very brief for the audience or the receiver, it should be comprehensible enough and
normal duration of a Video within a PPT generally lasts between 30 seconds to 5 minutes.
However, if the situation or the context of the situation requires a more shorter video clip
or a longer one, then there are no restrictions to it. However, the preciseness is always
appreciated while using such methods. So, one must be very cautious and aware about the
content of the video as well as the duration of it. Although in the instance of including a
video, one must remember that the PPT file size requires more storage, same goes with
the PPT’s with many images and designs. The size and storage that is required for a PPT
or the file size of the PPT is normally between 1MB to 20MB. However, this may vary
according to the content and number of slides within the PPT. It is also wise to remember
that, the PPT can be mailed or either uploaded in any online drive storage. However, in
case the PPT size is more than 25MB, it cannot be mailed. Although there are many
websites and apps through which one can reduce their file size but it is wise not to do that.
Because, the resolution of the PPT gets affected by the reduction of the file size. Therefore,
if such situations occurthen one must upload the file in a drive or in a Pen drive with
adequate or sufficient space.

Example of Video in PPT
Image Source: guidingtech
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2.8.9 Mastering Slide Layouts

To learn to create efficient PPT’s one must understand the basics of computer. Only
then the presenter would be able to create a PPT. Without the basic knowledge of
computer, it is not possible to create a PPT. Many of the students or presenters with basic
computer skills can learn and understand the various methods, ways and procedures either
through a particular course (specifically meant for understanding and learning design),
through online (such as YouTube) and from a teacher or a friend who knows the fundamentals
of PPT and has sufficient experience. However, a presenter with only the basic knowledge
of computer fails to create an effective PPT and the charm or effectiveness of the PPT gets
affected. Therefore, one must understand and enhance their skills to learn and acquire
knowledge about the PowerPoint presentation and learn the various types and ways to
enhance the visual effect of the PowerPoint presentation. The up-to-date knowledge of
technology, currently the coming of the Artificial Intelligence (Al) affected and further
enhanced the process of creating a PPT. One now easily create a PPT in a few simple
steps within a couple of minutes by providing ample instructions and keywords to the AL
The Artificial Intelligence itself creates a PPT for you now a days, only the command over
it needs to adequate and efficient enough to get the desired results. Therefore, one must
learn and uplift his/her skills to stay aloof and updated according to the scenarios.

2.8.10 Benefits of Learning PPT

Learning to create a profound PPT for its effective use can be beneficial in several
ways. Now-a-days, PPT’s has become a norm be it in the educational institutions, academic
field, professional services and in almost every other fields. Therefore, for the students of
academics or the learner, the PowerPoint presentation skills has become a necessary
aspect or skill to learn for their career perspective and career development wise. Learning
this specific skill not only develops your communication skills and presentation skills but
also develops a sound understanding of professionalism, time efficiency, public engagement
and also for the career readiness. Therefore, the PPT skills is not only necessary skill but
it has eventually transformed into a must have skill for any learner or any aspiring professional.
Therefore, it is time and again suggested to the students and learners that such kinds of
skills are necessary to learn and without this is becomes very difficult for any learner or
aspiring professional to move forward in getting a job or uplifting their career trajectory.

2.8.11 Summing Up

This module has looked upon and tried to elaborate all aspects of PPT or PowerPoint
Presentation. This module has highlighted all the major and key skills to possess and
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develop to create an effective PPT. Because the necessity of the PowerPoint Presentation
in field is a must have skill now-a-days. Therefore, the students and learners are provided
with a basic introduction to what the PowerPoint is about, how the program works, what
are the major areas and scopes of PPT and the various methods, aspects and procedures
or PowerPoint Presentation. As already mentioned above in this segment that, the necessity
of PowerPoint Presentation skill is a must and by therefore, students or learners or any
aspiring professional who wishes to get recruited, develop their career perspective and
trajectory, to develop communication skills and time efficiency, one must learn the PowerPoint
skills thoroughly. Because, the Audio-Visual method of the PPT has a profound effect in
all the existing field. However, it is need to kept in mind that the requirement of PPT varies
across the field and one needs to be very cautious before projecting their PPT through a
Projector in either a Projector Screen or in any such surface, because any complexity and
fake content or any of the restricted elements can put the presenter into trouble. The PPT
can so easily mislead or create diverse reactions and understanding amidst the audience or
the receivers. Therefore, it is better suggested for the presenters to be cautious while
creating and using PPT.

2.8.12 Comprehension Exercises

Long Answer Type Questions:
Q.1. What are the steps to create a PowerPoint Presentation? Discuss at length.

Q.2. What is PowerPoint? How to use PowerPoint by using Text, Image and Video?
Q.3. What are the benefits and limitations of PPT if any? Describe in detail.

Q.4. What are the ways to enhance PowerPoint presentation? In what manner the PPT
serve the according to purpose of the presentation through this?

Q.5. What impact does Al (Artificial Intelligence) has in PowerPoint making? Do you
think Al has reduced the required skill of the presentation?

Medium Length Answer Type Questions:
Q.1. Write a note on the PowerPoint program?

Q.2. What are the basic features of PowerPoint? Describe a few of the features of
PowerPoint program?

Q.3. Write a note on the significance of Audio-Visual method (PPT) in academics? How
far it is important to have PPT while presentation?

Q.4. Write a note on the decline of the skill of the create PPT amidst the rising technology?
How far it affects the presentation?
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Q.5. How far the images and videos are important in the context of PPT?

Q.6. What are the loopholes and backdrops of PPT? Is it an adequate medium to
transfer knowledge?

Short Length Answer Type Questions:
Q.1. What is slide in PowerPoint?
Q.2. What are the basic requirements in creating a PPT?

Q.3. Is the knowledge of creating a PPT sufficient enough for a successful presentation?
If not, what are the other aspects that is required for the successful presentation?

Q.4. What are the things to kept in mind while preparing a PPT? Is there any misleading
aspect of PPT?

Q.5. What are the difficulties in using the PPT? What are the necessary objects/technology
needed for a effective PPT presentation?

Q.6. Write a note on PPT as an Audio-Visual aid?

2.8.13 Keep: Suggested Readings

Moira, Stephen. Presentations with PowerPoint: Learning Made Simple. Routledge,
2006.

Bossé, Chantal. Microsoft PowerPoint Best Practices, Tips, and Techniques: An
Indispensable Guide to Mastering PowerPoint’s Advanced Tools to Create Engaging
Presentations. Packt Publishing, 2023.

Pitch, Kevin. Microsoft PowerPoint Guide for Success: Learn in a Guided Way to
Create, Edit & Format Your Presentations Documents to Visual Explain Your Projects
& ... Colleagues Big Four Consulting Firms Method. 2022.

Cox, Joyce. Microsoft PowerPoint 2013 Step by Step. Prentice Hall India Learning
Private Limited, 2013.

Shrivastava, Deepak. Preparation of Power Point Presentation Based on Research,
Insertion of Graphs, Charts & Figures In Presentation. Notion Press, 2020.

Kumar, Bittu. Microsoft Powerpoint 2010. V&S Publishers, 2017.

Carter, Liam. ChatGPT in Office 365: The Most Updated Guide to Skyrocket Your
Productivity by Unlocking the Power of Al in Word, PowerPoint, Excel and Beyond,
from Beginners to Advanced. Francesco CapulziniCremonini, 2024.
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Howell, Dusti D., Deanne K. Howell, and Marcus D. Childress. Using PowerPoint in the
Classroom. Corwin, 2006.

Niemi, Hannele, Roy D. Pea, and Yu Lu. A/ in Learning: Designing the Future. Kindle
Edition, Springer, 2022.

Devi, K. Gayathri, Kishore Balasubramanian, and Le Anh Ngoc. Machine Learning and
Deep Learning Techniques for Medical Science (Artificial Intelligence Al: Elementary
to Advanced Practices). CRC Press, 2022.

Other Learning Process of PowerPoint:
1. Crash Course on PowerPoint
2. Computer Learning (MS-Office, PowerPoint)
3. Online Free Platform (YouTube)



MODULE 3

Digital Communication and Networking
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Unit 9 3 Email and Communication Tools

Structure

3.9.1 Objectives

3.9.2 Introduction

3.9.3 Digital Humanities

394 Communication Tools

3.9.5. Importance of Communication Tools
3.9.6. Benefits of Communication Tools
3.9.7. Electronic or Email

3.9.8 Structure and Functions of Email

3.9.9. Digital Initiatives in Higher Education
3.9.10. Summing Up
3.9.11. Comprehension Exercises

3.9.12. Suggested Reasdings

3.9.1 Objectives

In this unit the students will get a glimpse of how computer skills and ICT (Information
and communication technology) are extremely important. In the contemporary world of
digitalisation very especially in the times of Post-Covid, the Emails and use of Communication
tools is layman’s saviour. There are hybrid meetings, Work from home relaxations, one can
have certification courses online, leaning a new language using YouTube and other social
media applications made our life easy, one can access them anywhere and everywhere.
Students also will get familiar with the emerging Communication tools and the fine usage
of emails. It will also emphasize the use of digital tools in the domain of humanities. This
unit acknowledges the significant influence of digital world and its communication and digital
tools and approaches in the teaching as well as research in the field of humanities. It also
connects the divide between traditional academic research and the ever-changing post
covid digitalisation world.
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3.9.2 Introduction

“Sharing is good and with digital technology sharing is easy”

Email and communication tools are the crucial in today’s world. One can never imagine
their life without them. They are just like the breath of a human being as our day beings
and end with the usage of the tools. If we look at the most basic of tool,we can start the
list with YouTubewhich is nowadays used in every home be it learning a new language, a
new cuisine, learn a new step for grove so on and so forth. It is getting incredibly popular
very especially after the reels came into fashion or the shorts in which just in a minute or
less than it we get a hands on a new lesson or a new recipe. Therefore, we started with
the YouTube which is used extensively but it we give a look, we will get to know there are
numerous applications which is extremely useful for example Emails, WhatsApp, Facebook,
Instagram, Google Meet, Microsoft Teams, Zoom, WebEx Meet etc. These are the tools
of communication used significantly in the 21* century to have a better communication as
after the pandemic Covid-19; we are connected globally more than physically. It’s a world
of connectivity, digital connections, we can attend the classes online, attend all the programs
for Under Graduates, Post Graduates etc.

Mobile Phones, Laptops, Ipads etc. are largely importantin 21% century as they have
access to everything under the sun. Now people are switching to digital media as well
which includes eBooks, newspapers, magazines and other digital media via wireless
networking Kindle is one of the major examples of it. Amazon kindle is a series of e-readers
designed and marketed by amazon. It is booklover’s best friend as it is thin and light for
one-handed reading, it holds thousands of books. Another brilliant feature which makes it
super fun to use is its battery, it lasts for weeks. It has sharp, dark text that reads like a
printed page. It also has whisper sync technology which synchronizes the last page read.It
has access to over three million books, including latest bestsellers and more than 30,000
free books.

Having such an exposure in just a tab like structure is a blessing indeed. Therefore,using
all these little gadgets makes our life richer in terms of knowledge. Just one click we have
access to the whole wide world.We can order food, clothes or anything we like; we meet
new friends online etc.

Email is a common mode of Communication that is widely used by the old as well as
young. Nowadays Email has become the natural communication channel as the telephone.
Computer Mediated Communication (CMC) is the only one with which the average Internet
user is familiar. If we look at the history of the Email it dates back to 1970’s. Until 1980’s
it was primarily used in Governmental and in the business. Another important perspective
to look at it that it has replaced telephone calls and the letter mails; therefore, it has become
very easier to approach.
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There are basically two new terms emerged that has been coined in the context of
Email and Computer Mediated Communication and they are Emalism and another is
Netspeak. “These both terms are attempts to define email and more precisely its linguistic
features. They suggest that the language of Email is a new previously unknown language
with unique features thus deserving its own term”

Communication tools are the channel that makes our life easy. In the era of digitalisation
one can never think their life without them. These tools can let us connect to other people
through various channels like- emails, video conferencing using Google Meet, Zoom,
Microsoft Teams etc.and phone calls. In the 21% century where digital proficiency is
inflating and it is critical amalgamation into digital world enhances teaching methodologies
as well as academic engagement. If we look at from the point of humanities it facilitates
the development of theoretical research as well as its practical implications.

3.9.3 Digital Humanities

It is an essential for Arts, Literature and the technology of language. It is very useful
in bridging traditional scholarship with the today’s modern technological advancements.”It
is an academic field concerned with the application of computational tools and methods to
traditional humanities disciplines such as literature, history, and philosophy.” It is the way
we systematically use the digital tools for the humanities; it is an emerging area as now in
this digitally evolved world we can never think out life without these tools as they help us
in the better understanding of everything. This is also the field which is continually growing
and changing. In computing there are hypertext, hypermedia, digital mapping, digital publishing
data mining etc.

3.9.4 Communication Tools

They are the important tools for communication as without them it is not possible to
imagine this digitally evolved world. These tools encompass a wide range of technology
designed to exchange information and interaction between individualsand organisations

There are various video Conferencing applications-
A. Google Meet- It is a video calling application developed by Google; it was designed
in the early months of COVID-19 pandemic to have access to online classes,

interviews, certification courses etc.In the post Covid era, it has become a necessity
as without this it is unfeasible to think about anything.

B. Microsoft Teams-This is also a video conferencing and workspace chat application.
As meetings are moving to the virtual environment, this collaboration application
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which is designed by Microsoft as a part of the Microsoft 365is getting edge in
today’s world.

C. Zoom- it is a video telephony software program where group meetings, online
classes can be held. It is avery useful tool now days. It is also very popular for
virtual meetings, webinars and video conferencing.

D. Slack- It is a messaging app for business

Social Media Platforms:
Facebook, WhatsAppLinkedIn, Instagram, Twitteretc.

We all are accustomed to use it in our day-to-day life as we are digitally more
connected to each other. It is also said about the excessive use of social media applications
that we barely know our neighbours and strongly know each other online; what an irony
it is. Therefore, these are the social media applications which help us to connect with each
other, share our stories; we upload our successes, our feelings, our day-to-day activities
on social media which helps us to connect with each other better. If we look at the
LinkedIn application, which is widely used for the job opportunitiesnowadays we can have
remote job, WFH (Work from Home) or any job we are looking and searching for posted
on that application, we just have to apply with a ready resume or CV in hand.

Collaborating Programs:

Collaboration means working with someone to produce something, if we look at the
collaborating programs we have Trello, Asana Basecamp etc. For Instance, Asana is a task
and project management tool help organize and manage work. Basecamp is team
collaboration software and Trello is a tool with cards, boards, list for task organisation.

File Sharing Plateforms

It is a very important feature in this digitalisation world, as our phone memory sometimes
becomes full so these are the applications we use to share file and the best thing about it
is that they are connected with our Emails. To give a few examples we have One Drive,
Google Drive, drop box, these all are the cloud storage devices for collaboration and
sharing.

Email

Gmail and Outlook are the widely regarded tools for sending and receiving email. Now
a days if we are working anywhere or even we are a student of any particular university,
or an organisation we shall have an organisation Email ID, also called the Official Email ID
which help us to get all the information related to the university, all the upcoming events and
the conferences, seminars, webinars, collaborating opportunities or students exchange
programs etc. on that mail, also when we have an Email ID mostly foreign universities
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consider this a green flag andwe have a great chances of getting selected for that internship
or the job and so forth.

The choice of these tools of communication which is part and parcel of 21st century,
as one cannot imagine their life without using these tools, they are significant, makes our
life easy and helpful.

3.9.5. Importance of Communication Tools

They are crucial for various reasons as they enhance the efficiency, reach of
communication and the effectiveness. If we look at the instant messaging and video and
conferencing tools, if any problem arises or if we have to resolve any query these things
make easy to address issue and make decisions. Another important thing that makes
communication tools more effective is their accessibility. These tools enable different time
zones and geographical locations also making sure that no matter wherever they are, they
should get connected. They also enhance Collaboration as tools like Trello and Asana help
people collaborating on the projects. There is improving workflow using these tools. We
feel a sense of belonging and collaborating when these remote working environments take
over. This is a fast, interconnected world where we are more connected online than
anything else.

Media Technology is also grouped in two categories, Synchronous Media and
Asynchronous Media. Synchronous Media is when all the participants are together at the
same time even though when they are in different time zones, they are scheduled or real
time interactions by phone, video or in person whereas Asynchronous Media is when
participants in learning process are at different times at different media, they can be accessed
by the audience at any time that they desire.

3.9.6. Benefits of Communication Tools

It has a self-paced learning, Individual learns by using different tools at his own pace
and not as a homogenous group. Learners or users can go backward and forward in
content and can start again at any point. Also it is not necessary that one should do it in
a sequential manner. There is also diverse audience and multiple features. Very importantly
it is much more economical when we learn a new course or a new language or anything
under the roof; it has a higher speed of delivery and has a wider reach. It can also be great
equalizer as same quality is delivered to the rich as well as the poor. They also felicitate
interdisciplinary work and they make sure that this contribution is accessible
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3.9.7. Electronic or Email

It is the fundamental communication tool that plays a very crucial role in professional
as well as personal settings. It is very important in humanities. Its accessibility, cost
effectiveness and versatility make it the important part of the intersections within the community
of humanities. A very important feature is that email integrates with other tools and digital
platforms. For example, calendars, cloud storage which enhances productivity and
organization. It is Asynchronous Communication as recipients can read and respond at their
own conveniences adhering to different time zones.

Types of Email Account

1. POP/ IMAP Account- It is based on Post Office Protocol and supports oftline
email management. Clients can retrieve all messages from server, stores them locally
and marks them unread. An IMAP (Internet message access protocol) allow their
users to work both online as well as offline.

2. Email Forwader- Email Accounts will forward any incoming mail to another Email
Address.

3. Mailing List- It consists of its members email address. Any mail sent to mailing
account will be distributed to all the subscribers of the mailing list.

4. Auto Responder- It is a readymade reply to any incoming mail.

5. Email Blackhole- This is used to avoid spam mails from certain address a black
hole is created to discard any messages coming from the address.

6. Email Bouncer- It is an automated message from an email system that informs the
sender that the email was not delivered.

3.9.8 Structure and Functions

There is a header that includes the sender’s name and email address, the subject line,
date and the time when the email was sent. There is a subject line which is a short sentence
that summarise the reason of the mail. It is followed by the body that is the main paragraph
of the email that communicates the main message. Address Book is also an essential feature
of E-mail as it is used to keep a record of all the E-mail address of people whom we must
wish to contact by E-mail.

Functions of Email

1. Protocols- Theyare the set of rules that helps to perform certain tasks.
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2. Unified Messaging- It is a combination of different media into one channel. A user
can access information into different media using a single device.

3. E-commerce (Electronic Commerce) It is used to buy sell and exchange the product
services and info through computer networks.

Types of E-Commerce
a. Business to Consumer (B2B)
b. Business to Business (B2B)
c. Consumer to consumer (C2C)
d. Peer to Peer (P2P)
e. Mobile to commerce (M-Commerce)

There are also the applications of E-commerce. Some of them are-Electronic Payments,
Banking gateways,E-Governance, BHIM (Bharat Interface for Money), they are the cashless
payments through the mobile phone and UPI (Unified Payments Interface) etc.

Below are some of the terms which should be kept in mind while learning about the
Digitalisation world

Teleconferencing — it is a virtual conference with the participants in different locations

E-Governance- It is ICT supported system used in administration or management of
Govt.

E-Government- By using ICT it provides services in maintenance of govt. operations
correctly. Also, WWW is the most useful medium in E-Governance.

3.9.9. Digital Initiatives in Higher Education

To improve the learning outcomes and also to break digital divide; to improve the
access and quality of learning, MHRD (Ministry of Human Resource Development) has
taken the initiative by the name (NMEICT) Nation Mission of Education through ICT
which is a major initiative to infuse digital education so there will be digitally accessible
world which helps people to connect and have an exposure globally. Some of the major
initiatives are-SWAYAM, SWAYAM PRABHA, NATIONAL DIGITAL LIBRABY (NDL),
E-YANTRA

Swayam- It is IT Massive Open Online Course (MOOQOC). It is a platform for providing
best quality education that can be accessed by anyone, anywhere anytime using Information
Technology. It is launched by Government of India to three cardinal principles that is access
(best teaching learning to the most disadvantaged), equity and quality. It is taught in classrooms
from 9" till Post Graduation. It has more than 1000 specially chosen faculty members.
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Courses that are offered on Swayam are in four Quadrants’; First is Vedio Tutorials, E-
Content, Self-Assessment followed by the last Discussion forums. SWAYAM is developed
by MHRD and AICTE.

Swayan Prabha- It is 34 Educational DTH channels, it is telecasting high quality
educational programs through 34 channels on 24x7bases. These DTH channels cover
higher education, school education from 9% to 12 standards. Contents are provided by
IIT’s UGC, CEC, NPTEL, NCERT and NIOS.

National Digital Library- It is the development towards building a national asset,
sanctioned by IIT Kharagpur

E-Yantra- They incorporate robotics into engineering education with the object of
engaging students. It is developed by IIT Bombay. It aims to create the next generation of
embedded systems engineers with a practical outlook to provide practical solutions to
some of the real world.

E-Shodh Sindhu It is also an important initiative from the government. It is a consortium
for higher education electronics. It has more than 15,000 international electronic journals
and e-books that are made available to all higher educational institutes through this.

Let’s take a look at the glossary of some important terms in ICT (Information
Communication Technology) that is very useful.

1. Baud- It is a unit of measurement at which the data can be transferred.
2. Host- A Computer that provides services to other computers.

3. Hypertext- A text which contain links to other texts
4

. Voice over internet protocol (VOIP) - It is audio communication using Internet
instead of Telephones.

9]

. Zip a file- To compress a data file using the Zip Algorithm

6. CUI (Character User Interface)- A way in which a computer user communicates
with a computer by entering commands as text.

7. WAP- Wireless Access Point

3.9.10. Summing Up

In this unit, we got to know about the communication tools and the usage of Electronic
mail, a world of digitalisation. The world has transformed digGone are the days when the
pigeons used to give letters and became the medium of communication. Gone are the days
when people used letters to communicate with each other. In this fast paced world where
we are more concerned about the latest store in the nearby mall or the just released 10S
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in the market, these tools help us a lot make our life better in every way possible. Just by
one click we are into a world of digitalisation, we can meet people overseas, we can learn
a foreign language just by sitting home, and we can work from home in our t-shirts and
comfy lowers. We can have anything we want, by just a click; therefore these tools play
an extremely important role in every aspect of life making our life trouble-free.

3.9.11. Comprehension Exercises

Long Answer Questions:
1. Define ‘Communication Tools’ and why it is useful?
2. What is the importance of Communication Tools in today’s era?
3. Is Digital Humanities an important part of Computer skills? Explain.
4. Describe the Digital Initiatives in Higher Education by MHRD.

Medium Length Answer Questions:
1. Give a brief description of Electronic Mail.
2. What are the Functions of Email? Elaborate.
3. What is the difference between Synchronous and Asynchronous Media?
4. Describe File Sharing Platforms. What is their significance?

Short Answer Questions:

1. What is Swayam and Swayam Prabha? Describe
What is E-yantra?
What is Google Meet, Zoom and Slack used for?
What is Dropbox and Google Drive?

il

3.9.12. Suggested Readings
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Unit 10 O Web Browsing for Research

Structure

3.10.1 Objective

3.10.2 Introduction

3.10.3 The Idea of World Wide Web

3.104 Methods of Web Browsing for Research
3.10.5 Online Research Tools and Apps

3.10.6 Websites and Databases

3.10.7 Advanced Research Techniques

3.10.8 Privacy and Plagiarism

3.10.9 Enhancement of Research through Web Browsing
3.10.10 Summing Up

3.10.11 Comprehension Exercises

3.10.12 Suggested Reading

3.10.1 Objective

The primary objective of this unit is to introduce and enhance the understanding of
students and scholars for using World Wide Web for conducting and enhancing their
research. The main idea is to introduce the scholars and researchers about several methods,
techniques, websites, databases, online access to digital archives, journals and several other
scholarly depositories to enhance their research works. Now-a-days, specifically after the
invention and global circulation of the internet medium, people can access millions of
research works and findings to improve their understanding about a particular phenomenon.
The accessibility and the reach offered by the internet, particularly through WWW (World
Wide Web) and the various websites and depositories, scholars are now accessing numerous
amounts of data and other scholarly findings. Therefore, such accessibility has also it’s
issues and limitations also. The aspect of unethical conduct, plagiarism and so on becomes
problematic in terms of a fair conduct of research. Therefore, it becomes very crucial to
understand the usage of the Web Browsing for the purpose of research.
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3.10.2 Introduction

The beginning of the 21st Century witnessed the tremendous impact of internet and the
World Wide Web in the life and activities of the people across the globe. The accessibility
provided by the internet through its websites and depositories, made it possible for everyone
to access any kinds of knowledge in his/her fingertips. That kind of accessibility also
impacted upon research also. We can now very easily access, read, understand any
particular phenomenon in a very brief moment. The numerous amounts of information, data
available in the form of digital archives, scholarly databases, journals, websites and so on,
has opened up a new dimension to research and its possibilities. The introduction of the
WWW, has in a way opened up new possibilities and the amount of data that can be used
and put into someone’s research work. In this way, not only the quality of research
improves but also, it’s validity and reliability get enhanced to enrich the impact of the
research. The limitations and obstacles that was set up by geographical space, accessibility
and time, has now been wiped out by the utilization of website browsing and its various
tools for conducting research. The government of India through its higher education activities
also advocated and implemented such digital archives, scholarly depositories such as Shodh-
Ganga and Shodh-Gangotri, digital libraries across several higher educational institutions
and so on. There are also many of journal and libraries across the world that can be
accessed through websites. There are also hundreds of research tools available in the form
of websites and apps that helps the research to take place with an economy of time and
effort. Therefore, it becomes essential for any researcher to have knowledge about such
mediums and tools for the enhancement of research.

3.10.3 The Idea of World Wide Web

The World Wide Web was invented in 1989 and since then it has drastically changed
the world in its operations and functions. It has opened up a new dimension of knowledge
where everything is available for anyone to know. However, the more crucial aspects of
WWW, has been its browsers and websites, through which one can access any known
phenomenon of the world. Therefore, in the field of research it became a very useful tool
for the researchers to explore their field of knowledge. Browsers like Google Chrome,
Opera, Mozilla Firefox, Internet Explorer and several many others enabled the researchers
to search for scholarly findings in scholarly depositories and archives. Several of the
websites has been created since the invention of the WWW for breaking down the barrier
of geographical space to send data across the world. Therefore, several of the magazines,
journals, libraries, archives and knowledge depositories across the world started to spread
their knowledge via websites or through the digital medium provided by the internet. Thus,
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the scholars and researchers can now access a wide range of database and knowledge
sitting in their home. Such has been the impact of World Wide Web that not only it reduces
time in analyzing, categorizing and storing knowledge and information but it has also provided
various tools and methods to the researchers to conduct their research.

3.10.4 Methods of Web Browsing for Research

It is a fact that there are numerous amounts of data and information available on the
websites. In fact, there are multiple Web Pages available for one single aspect or object.
The access to the websites and creating a website has been so easy that it becomes very
difficult for us to decide and judge the authenticity of that knowledge. Therefore, there are
particular website, depositories, digital archives and journals available and widely accepted
by the academicians around the world, which a researcher should follow. Websites such
as Google Scholar, JSTOR, Research Gate, PubMed, Microsoft Academic, IEEE Xplore,
Scopus, Semantic Scholar, Google Books and so on. However, one should be aware and
certain about the field of research and categories and search for such kinds of information
and databases in the websites. The search with keywords and specific field becomes very
crucial in order to get and fetch the desired result in a hassle-free manner. It is very
important for the researchers to search and browse in a particular efficient manner to
produce better search results. Therefore, it becomes essential for the scholars or researchers
to understand and apprehend the advance search techniques, such as, Site-specific searches,
Wildcard Searches, by using Boolean Operators (using ‘and’, ‘or’, ‘not’ etc.), VPN
usage, Incognito Mode, Bookmarking, Citation Management Software, Digital
Repositories, Data Visualization Tools, Web Archiving Tools, Google Driver, Google
Doc and so on.

3.10.5 Online Research Tools and Applications

One of the major contributions of the WWW or the internet has been the reduction
of time and omitting the barrier of geographical distances for the collection of data or any
kind of information. There are now-a-days thousands of websites and software available
which contributes to the field of research to reduce time and manual effort from the part
of the researchers. Before the invention of the internet and WWW, research has been
conducted in a pen-paper based medium. Those research outputs and knowledge written
on paper has time and again faced the wrath of time and became very vulnerable for
destruction. But, now-a-days, the digital archiving tools such as scanner, photocopy machines,
cloud storage and many other tools and software’s, gets used to preserve and analyze the
data through the internet or the digital mediums. Amidst such tools, Google Scholar is
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used for searching academic literature, Zotero is used for managing citations in various
research papers, Mendeley is used for collaborative research and sharing research, Survey
Monkey is used for creating and distributing online surveys, Research Gate is used for
connecting with other researchers and sharing one’s research, Evernote for organizing
research notes. Other than that, researchers use, Google Docs for writing and taking notes
for their research outputs, Google Driver for storing their data collection, Grammarly for
checking spelling and improving sentence constructions, Quillbot and so many others. Even
recently, the invention of OpenAl, has further improved Web browsing. There are several
other research tools available online, such as Project MUSE, Internet Archive, Perseus
Digital Library, Humanities Commons, RefWorks (a reference or citation management
tool) and so on. Therefore, it becomes very crucial for the scholars and researchers to
know and use such research tools and incorporate them in their research.

3.10. 6 Websites and Databases

There are hundreds and thousands of scholarly websites and databases available on
the web browsing portal, such as,

1. Google Scholar— https://scholar.google.com

. JSTOR — https://www.jstor.org

. Project MUSE- https://muse.jhu.edu

. PubMed — https://pubmed.ncbi.nlm.nih.gov

. ScienceDirect— https://www.sciencedirect.com

. SSRN (Social Science Research Network)— https://www.ssrn.com

N N b R~ W

. arXiv— https://arxiv.org

8. IEEE Xplore— https://ieeexplore.ieee.org

9. HathiTrust Digital Library— https://www.hathitrust.org

10. Open Access Button— https://openaccessbutton.org

11. CORE- https://core.ac.uk

12. DOAJ (Directory of Open Access Journals) — https://doaj.org
13. Google Books — https://books.google.com

14. Europeana — https://www.europeana.eu

15. Digital Public Library of America (DPLA)- https://dp.la
16. WorldCat— https://www.worldcat.org

17. Humanities Commons — https://hcommons.org

18. RefSeek— https://www.refseek.com
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19. The British Library — https://www.bl.uk
20. The National Archives— https://www.nationalarchives.gov.uk

These are some of the websites very popular among the scholars and researchers to
collect data and information for utilising them in their research work. However, this is just
a shortened list, there are hundreds and thousands of such kinds of websites and databases
available on the internet where the research works and text are well preserved categorically
in pdf or other available formats which the researchers can download, read, search, make
notes and do various other kinds of activities.

3.10.7 Advanced Research Techniques

The field of research in any field has been dynamic from ancient times. Therefore,
almost every decade, the form, shape, methods, structure and outcomes witnessed a
drastic shift due to the advancement of time and evolution of the human race. Since 1990’s,
the impact of the internet and WWW on research has witnessed a tremendous shift in
research techniques. Now, a scholar or any researcher cannot neglect the digital mediums
for their research. Therefore, a researcher now visits several websites and depositories to
collect data, and uses online tools to find out exactly what they require. The data processing,
analyzing are now solely done through the online medium. The researchers also use several
of the research tools to check the authenticity of the data, reliability of the sources,
plagiarism and many such other scholarly activities and findings. However, it becomes very
crucial for researchers to have knowledge about using keywords, which becomes crucial
in finding their exact match. Using several research tools and taking assistance to enhance
the research outcome has become very crucial.

3.10. 8 Privacy and Plagiarism

This is one of the utmost concerns and a severe issue regarding web browsing for
research. Very often it has been observed that the researchers tend to copy certain text and
other research outcomes in their research. There are several applications and online tools
available for altering the text and making it almost impossible for the examiner or others
to determine that. However, several initiatives have been taken up by the higher education
authorities to detect such kinds of malpractices. Even then it remains a significant concern
in the field of research because of the easy accessibility pf numerous amounts of data and
information in the World Wide Web. To combat this University Grants Commission of India
made it a mandatory course for the researchers to teach the scholars and researchers about
Research Ethics. It is so important for the scholar to understand that copying someone’s
research is not only concerning in the moral grounds but it also hampers the research
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works. There are several forms of plagiarism that a researcher needs to avoid, specifically
while using web browsing for research. Such kinds of plagiarism are-

(a) Global Plagiarism- Copying the entire text or research of someone or to claim
someone’s research as yours

(b) Paraphrasing Plagiarism- paraphrasing someone’s idea or research and claiming
it as original work

(c) Self-Plagiarism- Copying one’s own work or research or publishing parts of the
research without permission

(d) Accidental Plagiarism- When the researcher either intentionally or unintentionally
forgets to provide credit to the quote or phrase he or she has taken from someone’s
work

(e) Mosaic Plagiarism- This happens when the researcher provide citation with little
original thought

(f) Direct Plagiarism - Quoting or copying a complete section of someone’s work or
text without citing the author

(g) Patchwork Plagiarism- Copying texts from several sources and rearranging them
without proper citation

All in all, it is a very malpractice among the scholars to do such kinds of activities in
their research work. Therefore, providing proper citation (as per the limit) and indicating
the source as well as providing proper credit to the author becomes mandatory. One must
be aware about such practices and the researchers can check their plagiarism status of their
research work by themselves, using several applications, websites and tools available on
the website. It very often happens that the researchers mistakenly quote and forgets to do
a proper citation. Therefore, doing a plagiarism check from the institution authority or by
himself before submitting their research work becomes very important.

3.10.9 Enhancement of Research through Web Browsin

It has become very evident that the web browsing has improved the scope of research
by enabling and opening up a wide range of resources available in the fingertips of the
researchers. Accessing online journals, very often free and some with a minimal subscription
pay enables the researcher to search for his material by a keyword and store the copy of
the required article and store it digitally. Therefore, the number of texts, resources and data
available are plentiful in the websites. However, there are several sources readily available
on the web whose authenticity and validity are found to be objectionable. Website sources
such as Wikipedia, Quora, Google Pages are not considered authentic, therefore
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information found on such websites lack authenticity and hence the researcher should avoid
using such information whose authenticity and credibility cannot be traced. It is highly
recommended for the researchers to not cite or quote texts from vlog posts, webpages and
so on. The researchers can find a wide range of authentic sources in the websites as
already mentioned above. Therefore, incorporating the necessary components of their
research work via web browsing has to be done with proper caution.

3.10.10 Summing Up

It is very evident from the above information that the impact and use of Information
and Communication Tools (ICT), specifically in the form of websites or the web browsing,
has brought about a tremendous shift and a dynamic approach towards research. Therefore,
not only the use and incorporation of Website Browsing and collecting data and information
has become a significant part of research but it also has become an integral component of
any research work or project. Although it has its limitations too, therefore the researcher
needs to be quite careful in utilising such aspects in the research work. Morality, ethical
conduct, preserving integrity and loyalty, abstaining themselves from plagiarism, finding
reliable sources and selection of data and information are the key aspects for any researcher
to follow. If all such grounds and aspects are well obeyed by the researchers, then website
browsing provides them with plenty of opportunities to indulge themselves in the superior
field of knowledge and end up contributing significantly to the existing knowledge by
utilising such methods and techniques. The higher education authorities across the world
also influencing scholars and researchers to avail such facilities and maximise their opportunity
to enhance their research work by incorporating the digital mediums available.

3.10.11 Comprehension Exercises

Long Answer Type:

1. What is the importance of web browsing in research? How far it is essential to uplift
the research work for any researcher?

2. What are the ways a researcher can utilize web browsing for conducting their
research? Discuss at length.

3. What are the advantages and limitations of web browsing for research? Discuss at
length.
4. Are there any ethical issues in conducting research by utilising web browsing?

5. How far do you believe that web browsing facilitates research? Discuss some of
the points in detail.
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Medium Length Answer Type:

1.

5.

What are some of the websites and services that a researcher can incorporate and
collect data from the World Wide Web?

. What is the importance of selection and checking the authenticity of the sources

available on the websites, in the conclusion of data collection and analysing them?

. Discuss about some of the applications and software that are used in research

through web browsing?

. Point out some of the crucial websites, depositories and databases which are

reliable and useful for the researchers?

What is the benefit of digital archiving? How are the researchers benefited by it?

Short Length Answer Type:

1.
2.

What is plagiarism? Discuss briefly.

How to avoid plagiarism? What are the methods that a researcher should follow
to avoid plagiarism?

. What do you understand by web browsing for research? Point out some of the

benefits of it?

. What is the importance of using keywords while web browsing for research?

5. Why should anyone accept web browsing for research as an advanced research

method? Note down your argument concisely.

. What are the key aspects of web browsing for research, which the scholar or

researcher must understand before utilising that medium?
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Unit 11 O Project Management Tools

Structure

3.11.1 Objectives

3.11.2 Introduction

3.11.2 The Importance of Referencing in Research

3.11.3 Understanding Citation Styles: Focus on APA 7th Edition
3.114 Research Tools and Their Role in Enhancing Research Quality
3.11.5 Writing Assistance for Enhancing Academic Writing
3.11.6 Plagiarism Detection for Ensuring Originality

3.11.7 Literature Review and Search Strategies

3.11.8 Knowledge Mapping Tools

3.11.9 Tools for Writing and Editing

3.11.10  Citation Tools

3.11.11 Organizing References

3.11.12 Using Zotero and Mendeley for In-Text and End-Text Citations in
Document Files

3.11.13  Plagiarism and Its Implications in Research

3.11.14 Detection Tools

3.11.15 Al Detection in Plagiarism Tools

3.11.16 The Researcher’s Role in Controlling Research Tools
3.11.17 Summing Up

3.11.18 Comprehension/Practice Exercises

3.11.19 Suggested Readings

3.11.1 Objectives

® Understand the importance of proper referencing and citation in research.

® Explore different reference management tools and their functionalities.

® Learn the correct use of APA 7th referencing style.



NSOU ¢ NSE-EG-03 125

® Gain practical knowledge on how to use Zotero, Mendeley, and EndNote for
managing references and citations.

® Develop an understanding of plagiarism detection tools and their significance in
academic integrity.

o Integrate reference management tools with text editors for efficient writing and
formatting.

o Utilize Al-enhanced research assistants to optimize literature review and citation
management.

3.11.2 Introduction

In academic and research writing, proper referencing is crucial for maintaining credibility
and ensuring that intellectual property is appropriately acknowledged. Referencing allows
students and researchers to give due credit to original authors, avoid plagiarism, and
support their arguments with credible evidence. Additionally, well-structured citations enhance
the readability and reliability of research papers, making it easier for peers and reviewers
to verify sources and follow the research trail.

With the exponential growth of data and the increasing number of scholarly publications,
manually managing references has become a daunting and time-consuming task. Students
and researchers often deal with hundreds or even thousands of sources, making it challenging
to keep track of citations, ensure consistency in formatting, and adhere to specific referencing
styles required by journals and institutions. The process of manually entering citation details,
formatting them according to different styles (such as APA, MLA, Chicago, or Harvard),
and maintaining bibliographies can lead to errors and inefficiencies.

To address these challenges, reference management tools such as Zotero, Mendeley,
and EndNote provide structured ways to collect, store, organize, and cite references
efficiently. These tools automate many aspects of reference management, including metadata
extraction, citation formatting, and bibliography generation. They also offer additional
functionalities like PDF annotation, cloud synchronization, and collaboration features, enabling
students and researchers to enhance their productivity and streamline their research
workflows.

This module explores the significance of proper referencing in scholarly writing,
introduces key citation styles, and delves into the functionalities of reference management
software. By mastering these tools, students and researchers can significantly improve the
efficiency, accuracy, and organization of their citation processes, allowing them to focus
more on their core research activities.
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3.11.2 The Importance of Referencing in Research

Acknowledging Sources

Referencing is essential for recognizing the contributions of previous students and
researchers whose work has informed new research. Proper citation allows scholars to
attribute ideas, theories, and data to their original sources, ensuring academic integrity. It
also helps in avoiding plagiarism, which is the unethical practice of using someone else’s
work without proper acknowledgement. By citing sources correctly, students and researchers
demonstrate respect for intellectual property and uphold scholarly ethics.

Consistency and Clarity

Using a consistent citation style (such as APA, MLA, Chicago, or Harvard) ensures
that all references follow a standardized format, making research papers easier to read and
navigate. Clarity in citations helps readers locate the sources efficiently, cross-reference
details, and understand how various references contribute to the research. Journals and
institutions often have strict formatting guidelines and adherence to these styles enhances the
professional presentation of research.

Credibility and Professionalism

Proper referencing is a mark of rigorous academic work. It reflects the depth of
research conducted, the scholar’s engagement with relevant literature, and their ability to
synthesize existing knowledge. Citations provide evidence to support arguments and claims,
reinforcing the credibility of the research. Well-referenced papers are taken more seriously
by reviewers, peers, and readers, increasing the chances of publication and academic
recognition.

Avoiding Desk Rejection

Incorrect referencing can lead to serious consequences, including desk rejection by
journals. Many academic journals have stringent referencing requirements, and failure to
comply may result in an immediate rejection of the manuscript before peer review.
Furthermore, poor citation practices can lead to unclear arguments, misinterpretation of
sources, and an overall loss of credibility in academic discussions. By ensuring precise and
standardized referencing, students and researchers can improve the quality of their submissions
and enhance their chances of publication.
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3.11.3 Understanding Citation Styles: Focus on APA 7th Edi-
tion

APA 7th Edition Overview

The American Psychological Association (APA) 7th Edition is a widely used citation
style in social sciences, psychology, business, and management research. It provides a
structured approach for citing sources and formatting research papers, ensuring consistency
and clarity in scholarly communication. APA 7th Edition emphasizes simplicity, inclusivity,
and adaptability, making it suitable for various academic and professional contexts.

Key Elements of APA 7th Edition Citations

A properly formatted APA reference includes the following key elements:

® Author(s): List of contributors, formatted as Last Name, Initial(s) (e.g., Smith, J.
A).

® Year of Publication: Placed in parentheses immediately after the author’s name
(e.g., (2021)).

o Title of the Work: Italicized for books and journals; sentence-case capitalization
is used.

@ Journal Name: Full title of the journal, italicized.

® Volume and Issue Number: The volume is italicized, while the issue number
appears in parentheses (e.g., Journal of Research, 12(3), 45-67).

® Page Numbers: Required for journal articles, book chapters, and reports.

o Digital Object Identifier (DOI): A unique identifier for journal articles and digital
sources (e.g., https://doi.org/xxxx).

Example of a journal article citation in APA 7th format:

Smith, J. A., & Doe, R. B. (2021). Effective research strategies in psychology. Journal
of Psychological Studies, 12(3), 45-67. https://doi.org/xxxx

Example of a book citation in APA 7th format:

Brown, M. L. (2020). Advanced research techniques: A comprehensive guide.
Academic Press.
In-Text Citations in APA 7th Edition

In-text citations in APA 7th Edition follow one of two formats: parenthetical
citations or narrative citations.
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® Parenthetical Citation: The author’s name and publication year appear within
parentheses at the end of the sentence.

o Example: “Research suggests that reference management improves writing efficiency
(Smith, 2021).”

® Narrative Citation: The author’s name is incorporated into the sentence, followed
by the year in parentheses.

o Example: “Smith (2021) found that reference management tools improve writing
efficiency.”
When citing multiple authors:
® Two authors: (Smith & Doe, 2021) or “Smith and Doe (2021) state that...”

® Three or more authors: (Brown et al., 2020) or “Brown et al. (2020) argue
that...”

Formatting Rules in APA 7th Edition
® Reference List:
o Arranged in alphabetical order by author’s last name.

o Uses a hanging indent (the first line is flush left, while subsequent lines are
indented).

o Only include works that are cited in the paper.
o Title Page and Headings:
o Title should be bold and centered.
o Headings should follow APA’s structured format (Levels 1-5).
o Running head is not required for student papers.
® Tables and Figures:
o Clearly labeled with descriptive titles.
o Cited within the text and formatted according to APA guidelines.

By following APA 7th Edition guidelines, researchers ensure clarity, professionalism,
and consistency in their writing. Proper citation practices not only enhance the credibility
of academic work but also help students and researchers comply with ethical standards and
avoid plagiarism.
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3.11.4 Research Tools and Their Role in Enhancing Research

Quality

Search Engines for Comprehensive Literature Searches

Google Scholar: A widely used academic search engine providing access to scholarly
articles, conference papers, and books.

PubMed: A premier database for medical and life sciences research, offering a vast
repository of peer-reviewed studies.

Insight: A specialized platform for discovering trends, key papers, and influential
researchers in various academic disciplines.

Citation Management for Organizing and Citing References

Zotero: A free and open-source reference manager with excellent web integration
and group collaboration features.

Mendeley: A reference manager by Elsevier that allows users to store, annotate,
and cite research articles effortlessly.

EndNote: A professional-grade citation management tool with advanced
functionalities for large-scale research projects.

3.11.5 Writing Assistance for Enhancing Academic Writing

Grammarly: An Al-powered writing assistant that helps students and researchers
refine their grammar, style, and clarity.

QuillBot: A paraphrasing tool that aids in rewording and improving sentence
structures in academic writing.

Paperpile: A cloud-based reference manager that integrates with Google Docs and
facilitates seamless citation insertion.

3.11.6 Plagiarism Detection for Ensuring Originality

Turnitin: A leading plagiarism detection software widely used in academic institutions
to identify potential instances of copied content.

iAuthenticate: A tool designed for students and researchers to check manuscript
originality before submission to journals.
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3.11.7 Literature Review and Search Strategies

Effective Search Strategies

Conducting an effective literature review requires a strategic approach to searching
academic databases. The following methods help refine searches and ensure the retrieval
of high-quality research papers:

® Keyword Selection: Choosing relevant keywords based on the research question
is crucial. Using synonyms and related terms improves the comprehensiveness of
the search.

® Boolean Operators or Logical operators such as AND, OR, and NOT help
refine search results:

o AND narrows results by including both search terms (e.g., “climate change
AND policy”).

o OR broadens results by including either search term (e.g., “renewable energy
OR solar power”).

o NOT excludes specific terms from the search (e.g., “machine learning NOT
deep learning”).

® Use of Filters: Applying filters for publication year, language, document type, and
peer-reviewed articles ensures relevance and quality.

® Database-Specific Techniques: Some databases, such as PubMed, support MeSH
(Medical Subject Headings) terms, which improve precision in medical literature
searches.

3.11.8 Knowledge Mapping Tools

Knowledge mapping tools assist students and researchers in visualizing relationships
between academic papers, identifying influential works, and discovering emerging research
trends. Some of the most popular tools include:

® Research Rabbit: Helps students and researchers track citations, explore related
works, and build interactive citation networks.

® Connected Papers: Generates visual graphs of research papers based on similarity,
aiding in identifying foundational and recent studies in a field.

e Litmaps: A dynamic tool for creating citation maps, allowing students and researchers
to track evolving academic conversations and trends.
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3.11.9 Tools for Writing and Editing

Al-Based Tools

Al-powered writing tools help students and researchers refine their academic writing,
improve clarity, and enhance readability. Some notable Al-based tools include:

® QuillBot: A paraphrasing tool that restructures sentences while maintaining the
original meaning. It helps in rewriting abstracts, improving coherence, and avoiding
unintentional plagiarism.

@ Scriber: Assists in summarizing complex academic texts, generating concise abstracts,
and improving the readability of research papers.

3.11.10 Citation Tools

Citation tools automate the process of formatting references, ensuring consistency
across different citation styles. These tools help streamline reference formatting within
research papers:

® Zotero: Enables direct citation insertion into documents and automatic bibliography
generation.

® Mendeley: Provides citation tools that integrate seamlessly with Microsoft Word.

o EndNote: Offers advanced citation management features, allowing users to apply
and switch between thousands of citation styles effortlessly.

Introduction to Reference Management Software: Zotero and Mendeley
Zotero

® Free and Open-Source: Zotero is a free, open-source reference management tool
that offers extensive customization options and is supported by a strong research
community.

® Three-Panel Interface: The software is organized into three primary panels:

o Library Panel: Displays collections and subcollections where references are
stored.

o Item List Panel: Lists all references within a selected collection.

o Details Panel: Provides metadata information, including author names,
publication details, and notes.

® Browser Extension: Zotero allows direct saving of references from databases like
Google Scholar, PubMed, and university repositories.
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® Al-Powered Research Assistant (ARA): Zotero integrates with Al tools to
summarize, compare, and analyze references, helping students and researchers extract
key insights from academic papers.

® Integration: Seamlessly integrates with Microsoft Word and Google Docs, allowing
easy citation insertion and bibliography generation.

Mendeley
® Free Reference Manager: Developed by Elsevier, Mendeley is a popular reference
management tool that offers robust organizational and citation capabilities.

® Cross-Platform Compatibility: Mendeley is available for Windows, macOS, and
Linux, ensuring accessibility across different operating systems.

® PDF Annotation: Users can highlight text, add comments, and annotate PDFs
within the software, making it a comprehensive tool for literature review.

® Collaboration: Mendeley allows students and researchers to share reference
collections with co-authors and collaborators, facilitating teamwork and information
exchange.

® Automatic Bibliography Generation: With its integration into Microsoft Word
and other writing tools, Mendeley enables automatic citation insertion and bibliography
formatting in multiple citation styles.

Building and Managing a Zotero and Mendeley Library
Adding References

® Zotero: Allows manual entry, direct PDF saving, drag-and-drop organization, and
Al-based interaction for efficient reference management.

® Mendeley: Supports manual entry, importing data from online sources, dragging
and dropping PDFs, and using the Mendeley Web Importer to collect references
directly from web pages.

3.11.11 Organizing References

® Creating Folders: Both Zotero and Mendeley enable users to create folders
(collections) and subfolders to categorize references based on research topics,
projects, or themes.

® Tagging: Users can assign tags to references, making it easier to filter and retrieve
relevant sources.
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o Built-in Duplicate Checkers: Both tools include duplicate detection features that
help identify and merge duplicate references, ensuring a clean and organized reference

library.

3.11.12 Using Zotero and Mendeley for In-Text and End-Text
Citations in Document Files

Inserting Citations

® Both Zotero and Mendeley allow users to search for and add references directly
within a document.

® In Microsoft Word and Google Docs, users can insert citations by selecting the
appropriate reference from their library and automatically generating the correct in-
text citation format.

o Citations can be added using author names, titles, or keywords.

Generating Bibliographies
® Zotero and Mendeley automatically compile reference lists based on the citations
included in the document.

@ Users can insert a bibliography at the end of the document with a single click.
® The bibliography updates dynamically as new citations are added.

Switching Citation Styles

® Both tools support multiple citation styles, including APA, MLA, Chicago, and
Harvard.

® Users can easily switch between styles without manually editing citations.

® The selected style automatically formats in-text citations and the bibliography
accordingly.

o with a single click.

o Unlinking Citations: Convert citations to plain text for final document sharing.

3.11.13 Plagiarism and Its Implications in Research

Definition

Plagiarism is the act of presenting someone else’s work, ideas, or intellectual property
as one’s own without proper acknowledgement. It is considered a serious ethical violation
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in academia and research, leading to reputational damage, academic penalties, and even
legal consequences.

Types of Plagiarism

1.
2.
3.

Direct Plagiarism: Copying text verbatim from another source without citation.
Self-Plagiarism: Reusing one’s own previous work without proper citation.

Paraphrasing Without Acknowledgment: Rewriting someone else’s ideas without
citing the original source.

Mosaic Plagiarism: Patching together phrases from multiple sources without proper
attribution.

Accidental Plagiarism: Failing to cite sources due to oversight or lack of
understanding of citation rules.

3.11.14 Detection Tools

To maintain academic integrity, various tools are available to detect and prevent
plagiarism:
® Free Tools:

o DupliChecker: Offers basic plagiarism detection and text comparison.

o Qtext: Provides Al-based content analysis to identify copied material.

® Paid Tools:

o Turnitin: A widely used academic plagiarism checker that compares submissions
against a vast database of scholarly content.

o iAuthenticate: Used by publishers, students and researchers to detect
similarities in manuscripts before submission.

3.11.15 Al Detection in Plagiarism Tools

With the rise of Al-generated content, plagiarism detection tools have incorporated Al-
detection capabilities:

® Turnitin AI Detection: Identifies text generated by Al writing tools and flags

potential non-original content.

® Grammarly’s Plagiarism Checker: Offers Al-based writing analysis to improve

originality and citation accuracy.

® Copyleaks Al Detector: Specialized in detecting Al-generated text to maintain

content authenticity.
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3.11.16 The Researcher’s Role in Controlling Research Tools

Critical Evaluation

While reference management and research tools provide automation and efficiency,
students and researchers must critically evaluate the outputs generated by these tools.
Automated citations, bibliographies, and metadata extraction may contain errors or
inconsistencies, necessitating manual verification. Ensuring accuracy in referencing maintains
academic integrity and prevents misrepresentation of sources.

Human Judgment

Although technology aids in streamlining research processes, it does not replace human
judgment. Students and researchers must engage in critical thinking to assess the credibility
of sources, apply proper citation practices, and verify the relevance of references. Relying
solely on automated tools without scrutiny may lead to inaccuracies, affecting the overall
quality of research. Effective use of research tools involves a balance between automation
and scholarly discernment.

3.11.17 Summing Up

This unit has provided an overview of the significance of proper referencing, key
citation styles, and how to efficiently use reference management tools like Zotero and
Mendeley. Students and researchers must balance technological assistance with critical
evaluation to maintain accuracy and uphold ethical research standards. Proper citation
management ensures clarity, credibility, and consistency in academic writing, reducing errors
and streamlining research workflows.

By integrating tools such as Zotero and Mendeley, students and researchers can
efficiently organize their references, automate citation formatting, and improve their overall
productivity. However, human oversight remains essential in verifying the accuracy of
references, ensuring adherence to institutional guidelines, and maintaining the integrity of
academic work. The ability to critically assess tool outputs and refine research methods
ultimately leads to a more effective and professional approach to scholarly writing.

Understanding and effectively utilizing these tools not only saves time but also enhances
research quality and facilitates collaboration among scholars. Mastering reference
management tools empowers students and researchers to focus on the content of their
work while ensuring compliance with citation standards, thereby strengthening their
contributions to academic and scientific communities.
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3.11.18 Comprehension Exercises

1. Why is referencing important in academic writing?

2. List three benefits of using a reference management tool.
3.
4
5

What are the key elements included in an APA 7th edition reference?

. Describe three different ways to add references to Zotero and Mendeley.

. How do Zotero and Mendeley integrate with Microsoft Word for citation

management?

6. Identify two free and two paid plagiarism detection tools.

7. Explain why students and researchers should verify the outputs of Al-based writing

and citation tools.

. What are the advantages of using Al-powered research assistants in Zotero?

3.11.19 Suggested Readings

American Psychological Association (2020). Publication Manual of the American
Psychological Association (7th ed.).

Neville, C. (2016). The Complete Guide to Referencing and Avoiding Plagiarism.

Creswell, J. W., & Creswell, J. D. (2018). Research Design: Qualitative, Quantitative,
and Mixed Methods Approaches.

Glatthorn, A. A., & Joyner, R. L. (2018). Writing the Winning Thesis or Dissertation.

Articles from Google Scholar and PubMed on reference management and citation best
practices.
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Unit 12 1 Internet Ethics

Structure

3.12.1.
3.12.2.
3.12.3.
3.12.4.
3.12.5.
3.12.6.
3.12.7.
3.12.8.
3.12.9.
3.12.10.
3.12.11.
3.12.12.

Objectives

Introduction

History and Development

Internet as a Research Tool

Academic Integrity in AI-dominated Digital Space
Privacy and Safety Protocols

Issues and Concerns

Use of Social Media and Ethics

Challengesand Scopesof Internet Research Ethics
Summing Up

Comprehension Exercises

Suggested Readings

3.12.1. Objectives

By the end of this module, students will be able to:
Understand the fundamental principles of ethical Internet use.

Utilise the Internet as a research tool effectively and responsibly.
Apply safe browsing techniques while conducting research online.
Use the Internet to gather and prepare valuable anecdotes.
Follow safety protocols to protect personal data.

Evaluate the advantages and challenges of Al in the digital space.
Engage with social media platforms ethically and responsibly.

Recognise the challenges and limitations of using the Internet as a research resource.

3.12.2. Introduction

The Internet has become an essential tool for communication, research, and learning
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in the modern world. It provides vast resources for humanities students, enabling easy
access to information, academic materials, and collaborative opportunities. However, ethical
Internet use is crucial to ensure responsible digital behaviour, data security, and academic
integrity.

This module introduces students to the fundamental principles of Internet ethics, including
responsible online research, copyright awareness, and digital privacy. It highlights the
importance of safe browsing, fact-checking, and avoiding plagiarism. Additionally, students
will explore the ethical use of social media and the impact of Artificial Intelligence in the
digital space.

Students can effectively develop critical thinking skills for navigating the online world
by understanding these aspects. The module will equip them with best practices to engage
ethically and responsibly with digital resources, ensuring they make informed and ethical
choices in their academic and professional lives.

3.12.3. History and Development

The growing reliance on the Internet for research has led to an increased focus on
ethical considerations. During the mid-1990s, when Internet research began to expand,
ethical concerns emerged alongside its development. At that time, the Internet was mainly
used for emails, messages, and chats. Ethical issues may not be well-defined in the early
stages of any field, but as research evolves, more data is gathered. With the shift from
human interaction to virtual spaces, the nature of research changed, impacting both researchers
and their methods.

This shift can be attributed to continuous advancements in information and communication
technology. The Internet has transformed how data is accessed, collected, and shared. The
availability of vast information and interactive features has made the Internet a valuable
educational tool. Additionally, the Internet has fostered a “Network Society,” allowing
researchers to collaborate across geographical boundaries.

Internet research ethics (IRE) vary by discipline. While traditional ethical guidelines
remain relevant, some fields, especially in the humanities and arts, focus more on
representation and context than human subjects, assuming minimal risk. However, ethical
challenges arise when gathering online data, particularly from personal interviews, historical
accounts, and medical records. If such data is made public, confidentiality may be
compromised. The American Historical Association (A. Jones, 2008) argued that such
research should be exempt from ethical review board oversight. However, if data becomes
publicly accessible, unforeseen privacy, reputation, or financial security risks may arise.

A similar debate surrounds the use of blog content. Since blog posts are typically
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considered public material, researchers do not require permission to cite them. By the mid-
2000s, a significant body of literature on IRE had emerged, supported by several anthologies
and research studies. Review boards assessing Internet research increasingly focused on
ethical concerns. A study by Buchanan and Ess surveyed over 700 ethics review boards
in the U.S. found that primary concerns included privacy, data security, confidentiality,
informed consent, and recruitment procedures (Buchanan & Ess, 2009; Buchanan &
Hvizdak, 2009).

Since 2008, IRE has become an integral part of research across disciplines. Fields not
traditionally associated with human subject research, such as computer security and information
and communication technology (ICT), have also begun exploring ethical considerations.
Researchers in these areas actively examine ethical guidelines to ensure responsible research
practices in the digital era.

3.12.4. Internet as a Research Tool

The Internet has revolutionised research by providing instant access to vast information.
It is a powerful tool for students, scholars, and professionals to gather data, analyse trends,
and stay updated with the latest field developments. Unlike traditional research methods
that rely on libraries and physical archives, the Internet offers convenience, speed, and
accessibility, making research more efficient and comprehensive.

® One of the most significant advantages of the Internet as a research tool is the
availability of academic databases and digital libraries. Platforms like Google
Scholar, JSTOR, and ResearchGate provide access to scholarly articles, research
papers, and books. Open-access journals and institutional repositories further enhance
knowledge-sharing by making high-quality academic content freely available.

® Another key benefit is the ability to use search engines effectively. Google, Bing,
and specialised academic search tools help researchers locate relevant sources
quickly. By using advanced search techniques such as Boolean operators and
filters, users can refine their searches to find precise information.

® Online surveys and data collection tools have also transformed research
methodologies. Platforms like Google Forms, SurveyMonkey, and Qualtrics allow
researchers to design surveys, collect responses, and analyse data efficiently. This
has made it easier to conduct large-scale research without geographical limitations.

@ However, while the Internet offers immense benefits, researchers must also be
cautious of misinformation and unreliable sources. Not all online content is
credible, and distinguishing between fact and opinion is essential. Websites without
proper citations, biased blogs, and social media posts often spread misleading
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information. Researchers must verify sources and cross-check facts before using
them in their work.

® Moreover, issues related to plagiarism and copyright arise when using online
content. Ethical research practices require proper citation of sources to avoid
academic dishonesty. Various plagiarism detection tools, such as Turnitin and
Grammarly, help ensure originality and adherence to research ethics.

® The Internet is a valuable research tool that provides quick access to diverse
information, facilitates collaboration, and enhances research methodologies. However,
responsible use, source evaluation, and ethical considerations are crucial to ensuring
the online research’s accuracy and integrity.

3.12.5. Academic Integrity in AI-dominated Digital Space

The rise of artificial intelligence (AI) has transformed the academic landscape, offering
students and researchers powerful tools for learning, writing, and conducting research. Al-
driven platforms like ChatGPT, Grammarly, Turnitin, and other generative Al models have
become widely used for writing assistance, content creation, and problem-solving. While
these tools can enhance academic work, they also raise serious concerns about academic
integrity, ethical use, and the authenticity of knowledge production in the digital age.

One of the most pressing concerns in an Al-dominated academic space is plagiarism.
With Al-powered writing tools capable of generating essays, reports, and even research
papers, there is a growing risk of students submitting Al-generated content as their work.
Traditional plagiarism detection software may struggle to identify Al-written text, making it
more difficult for educators to assess originality. To uphold academic integrity, institutions
must redefine their policies, incorporate Al detection tools, and encourage students to use
Al ethically for learning rather than as a shortcut to completing assignments.

Another significant issue is the reliability and accuracy of Al-generated information. Al
models rely on vast datasets to generate responses, but they do not always verify the
credibility of their sources. This can lead to the spread of misinformation, factual inaccuracies,
or biased perspectives. Academic integrity requires students and researchers to critically
evaluate Al-generated content, cross-check facts, and ensure their work is based on
credible sources rather than blindly accepting Al outputs.

The ethical use of Al in research is also a key concern. Al tools can analyse vast
amounts of data, generate summaries, and assist in literature reviews, but their use must be
transparent. Researchers must acknowledge the role of Al in their work and ensure that
it does not replace human analysis and critical thinking. Ethical academic practices include
properly citing Al-generated content, using Al as a supplementary tool rather than a
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replacement for original thought, and maintaining transparency about how Al has been used
in research and writing.

Maintaining academic integrity in an Al-dominated digital space requires a balanced
approach. While Al can enhance learning and research, its ethical use must be prioritised.
Institutions must establish clear policies, educators must adapt their teaching and assessment
methods, and students must develop critical thinking skills to engage with Al responsibly.
By fostering a culture of academic honesty, transparency, and ethical Al use, we can ensure
that Al is a valuable tool rather than a threat to academic integrity.

3.12.6. Privacy and Safety Protocols

In today’s digital world, safeguarding privacy and ensuring online safety are essential.
With the increasing risks of cyber threats, identity theft, and data breaches, individuals must
adopt security measures to protect their personal information. Various tools and protocols
help users navigate the internet securely while minimising risks.

Secure browsing practices also play a crucial role in online safety. Websites that use
HTTPS encryption protect data from being intercepted by third parties. Regularly clearing
browser cookies and cache helps remove stored data that might compromise privacy.
Installing and updating antivirus software and firewalls further strengthens security by detecting
and blocking potential threats.

Social media platforms require careful handling of privacy settings. Users should limit
the visibility of personal information, disable location sharing, and avoid posting sensitive
details such as phone numbers or addresses. Similarly, caution should be exercised with
emails to prevent phishing attacks. Suspicious links and attachments should never be
opened without verifying the sender’s authenticity, as they may contain malware or be used
to steal sensitive data.

Backing up data regularly is another vital safety measure. Storing important files on
secure cloud platforms or external drives ensures that data remains accessible in case of
cyberattacks or system failures. Ethical internet use, especially in the era of artificial
intelligence, is also vital. Users must verify information from credible sources and ensure
that Al-generated content is used responsibly.

3.12.7. Issues and Concerns

The rapid expansion of the Internet has brought several ethical concerns that impact
users, especially students and researchers. One major issue is data privacy, as websites
and third parties often collect, store, and misuse personal information. Cybersecurity
threats, such as hacking, phishing, and identity theft, also pose user risks.
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Another key concern is plagiarism and intellectual property rights. Many students
unknowingly violate copyright laws by using online content without proper attribution. The
widespread availability of Al tools further complicates originality and academic integrity.

Misinformation and fake news are major challenges, affecting critical thinking and
decision-making. Social media, while applicable for communication, raises concerns
about cyberbullying, online harassment, and digital addiction.

Finally, ethical concerns arise in Al-generated content and its impact on human creativity
and employment. Addressing these issues requires responsible Internet use, awareness of
ethical guidelines, and adopting safe online practices.

3.12.8. Use of Social Media and Ethics

Social media has become integral to modern communication, shaping how people
interact, share information, and express opinions. Platforms like Facebook, Instagram,
Twitter/X, and LinkedIn connect individuals worldwide, enabling instant communication
and access to vast amounts of information. While social media offers numerous benefits,
it also raises significant ethical concerns that users must be aware of.

One of the primary ethical concerns surrounding social media is privacy. Many users
unknowingly share personal information that can be misused by third parties, leading to
issues like identity theft, cyberstalking, and data breaches. Social media companies collect
vast amounts of user data, often without explicit consent, and use it for targeted advertising
and other commercial purposes. Ethical social media use requires individuals to be mindful
of their privacy settings, limit the amount of personal information shared, and be aware of
how their data is being used.

Misinformation and fake news are also major ethical challenges in the digital age.
Social media allows for the rapid spread of unverified or false information, influencing
public opinion and even affecting political events. Many individuals share content without
fact-checking, leading to widespread misinformation. Ethical social media users must take
responsibility for verifying information before sharing it and rely on credible sources to
avoid spreading false narratives.

Cyberbullying and online harassment are serious ethical issues that affect individuals,
particularly young users. The anonymity provided by social media can encourage negative
behaviour, where people engage in abusive, threatening, or harmful interactions. This can
have severe psychological effects on victims, leading to anxiety, depression, and in extreme
cases, self-harm. Ethical behaviour on social media requires users to engage in respectful
communication, report abusive content, and support anti-cyberbullying initiatives.

Another ethical concern is the impact of social media on mental health. The curated
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and often unrealistic portrayal of life on social media can lead to issues like low self-esteem,
anxiety, and depression. Many users compare themselves to idealised images and lifestyles,
leading to feelings of inadequacy. Ethical usage of social media includes promoting realistic
and positive interactions, avoiding toxic content, and encouraging mental well-being by
balancing online and offline life.

Social media also raises concerns about digital addiction. The constant need to check
notifications, likes, and comments can lead to excessive screen time, reducing productivity
and affecting real-world relationships. Ethical use of social media involves self-regulation,
setting limits on screen time, and prioritising meaningful interactions over passive scrolling.

Ethical considerations in the academic and professional spheres include plagiarism,
intellectual property rights, and maintaining professional decorum. Sharing someone else’s
work without proper credit or spreading confidential company information can have legal
and ethical implications. Users should always respect copyright laws, give due credit, and
ensure their online behaviour aligns with professional standards.

In conclusion, while social media is an assertive communication, awareness, and business
tool, it also requires responsible and ethical usage. Users must be mindful of their privacy,
avoid spreading misinformation, engage respectfully, and protect their mental well-being.
Ethical social media practices ensure that digital interactions remain positive, safe, and
beneficial.

3.12.9. Challenges and Scopes of Internet Research Ethics

The rapid expansion of the Internet has raised several ethical challenges. Privacy
breaches, cyberbullying, misinformation, and data security threats are growing concerns.
Users often share personal information without realising the risks, making them vulnerable
to identity theft and surveillance. Additionally, digital plagiarism and copyright violations
challenge academic integrity, while unethical Al applications raise concerns about bias and
manipulation. The anonymity of the online world also fuels unethical behaviour, making
regulation difficult.

Despite these challenges, Internet ethics offers significant opportunities. Ethical guidelines
can promote responsible digital behaviour, ensuring transparency, security, and fairness in
online interactions. Cyber laws, digital literacy programs, and ethical Al development can
create a safer online environment. Moreover, ethical Internet practices encourage critical
thinking, fostering informed and responsible digital citizens. By integrating ethical standards
into Internet use, society can maximise the benefits of digital advancements while minimising
their risks.
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3.12.10. Summing Up

This module explores the ethical dimensions of Internet usage, particularly in research,
communication, and digital interactions. With the growing reliance on the Internet for academic
and personal purposes, ethical concerns such as privacy, data security, misinformation, and
responsible online behaviour have become crucial.

The module highlights how the Internet is a powerful research tool, enabling global
access to vast amounts of information. However, ethical challenges arise in data collection,
plagiarism, and Al-generated content. Academic integrity in a digital space requires
responsible sourcing, proper citation, and awareness of Al’s role in research and content
creation.

Privacy and safety protocols, including cybersecurity measures and ethical social media
use, are also emphasised. The module addresses responsible online engagement, including
respectful discourse, avoiding cyberbullying, and ensuring informed consent in research.

By fostering ethical Internet practices, this module equips students with the knowledge

to navigate digital spaces responsibly, ensuring security, integrity, and fairness in their online
activities.

3.12.11. Comprehension Exercises

1. Write a 500-word essay on how ethical considerations shape how we use the
Internet, discussing challenges and responsibilities in the digital space.

2. Read a case study on an online privacy breach or misinformation incident. Identify
the ethical issues involved and suggest ways to prevent such incidents.

3. Take a 24-hour break from social media or a specific online activity. Reflect on
how it impacts your mental health, productivity, and ethical awareness.

4. Design an awareness poster or social media campaign against cyberbullying and
online harassment, highlighting ethical solutions.

5. Choose a trending news topic and fact-check multiple sources—present findings on
credibility, biases, and ethical reporting in digital journalism.

3.12.12. Suggested Readings

Sharma, Vakul. /nformation Technology Law and Practice. Universal Law Publishing,
2019.

Singh, Priti. Digital Humanities and Ethics: The Indian Context. Springer, 2021.
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Menon, Nivedita, and Aditya Nigam. Power and Contestation: India Since 1989. Zed
Books, 2007.

Ess, Charles. Digital Media Ethics. Polity Press, 2020.

Himma, Kenneth Einar, and Herman T. Tavani, editors. 7he Handbook of Information
and Computer Ethics.Wiley, 2008.





